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| 2. PRODUCT INTRODUCTION I

The Micro-C Series digital displays are versatile, cost effective solution to a wide range of
monitoring and control applications including frequency, rate, total, period, time, phase, posi-
tion, flow, and serial input display. Setup can be via front panel pushbuttons or a PC, and
allows the user to customize the meter for a specific application, with direct readout in
engineering units. Selective security lockout of front panel setup protects against accidental or
unauthorized setup changes, and simplifies meter use.

Choice of digit & case sizes: Micro-C  .56” red or green digits & 1/8 DIN case; Mighty-1C 1”
digits; Mighty-5C , 5” super-bright indoor/outdoor digits in a NEMA-4X designed case.

A dual-channel pulse or AC input signal conditioner and powerful firmware accommodate
a wide range of applications, including rate/frequency, totalizing, timing, phase angle, and duty
cycle. Frequency and rate are determined by taking the inverse of period. Fast read rate
provides an accurate display of peak or valley signals, and quick response for control appli-
cations. Adaptive filtering ensures stable displayed readings and outputs while responding
rapidly to actual changes of the input signal. A high stability quartz crystal and digital calibra-
tion of all ranges are used for rate and analog measurements.

A process receiver & totalizer signal conditioner accepts 4-20 mA, 0-1 mA or 0-10V analog
signals for display of rate or position. Square root is selectable for use with differential pressure
flow transducers.

A quadrature signal conditioner  provides a highly accurate display of position, angle, or rate.

Alarm and control can be provided by two optional Form C (8A @ 250 Vac) contact relays or
two solid state relays. The relays can be configured to be latching or non-latching, and to be
energized above or below the setpoint, or in a fail-safe mode.

An analog transmitter output  scaled to the display can be provided by an optional isolated
analog output board with selectable 0-20 mA, 4-20 mA and 0-10V ranges.

Five communication options (RS232/USB RS485/USB or R485-Modbus) can convert the
meter from stand-alone to system use, with interface with computers, PLC’s or other meters.
PC-compatible Instrument Setup software is available at no charge to set up the units via the
serial interface.

Operation as a 6-digit serial input meter  is achieved with a serial interface and no signal
conditioner. The unit can serve as a remote display with serial data from a computer, PLC or
other meter. With a dual relay board, it can provide local alarm or On/Off control. With an
analog output board, it can also serve as a local transmitter.

The Micro-C & Mighty-1C power supplies use a lightweight, high-efficiency switching type thahc
operate from either AC or DC voltages and complieh gétfety regulations. The standard supply allows
these meters to be powered worldwide from 95 to 240 Vac +10%p#aonal supply operates from
batteries or low voltage sources such as 8-34 Vac. Aibugolated excitation supply with jumper-
selectable 5, 10 or 24 Vdc output levels can eliminatedkd for an external sensor power supply. The
Micro-C & Mighty-1C cases are sealed to NEMA-4X (IP6%)en panel mounted. Model Mighty-5C
features an aluminum NEMA-4X case for surface or bragieinting suitable for mounting outdoors.

All wiring is via removable plugs conforming to IEC950 safégndards. All output options are isolated
from meter and power ground to 250 Vac.
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| 3. RECEIVING & UPACKING I

Your meter was carefully tested and inspected prior to shipment. Should the meter be
damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or
replacement. Please include a detailed description of the problem.

| 4. SAFETY CONSIDERATIONS I

A Warning : Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.

Caution:

Your meter can be powered with AC (mains) from 95-240 Vac +10% (90-300 Vdc) with the
high voltage power supply option, or 10-34 Vac +10% (10-48 Vdc) with the low voltage
power supply option (Micro-C and Might-1C only). Verify that the proper power option is
installed for the power to be used. Your meter has no AC (mains) switch. It will be in
operation as soon as power is connected.

The 95-240 Vac (95-300 Vdc) mains connector (P1 Pins 1-3) is colored Green to
differentiate it from other input and output connectors. The 10-34 Vac (10-48 Vdc) mains
connector is colored Black.

Do not make signal wiring changes or connections when power is applied to the meter.
Make signal connections before power is applied. If reconnection is required, disconnect
the AC (mains) power before such wiring is attempted.

To prevent electrical or fire hazard, do not expose the meter to excessive moisture.

Do not operate the meter in the presence of flammable gases or fumes; such an envi-
ronment constitutes a definite safety hazard.

This meter is designed to be mounted in a metal panel. Verify the panel cutout dimensions,
and mount according to instructions.

Symbols used

A
A\

O

Caution (refer to accompanying documents) —L— Earth (ground) terminal.

Caution, risk of electric shock. “N\_ Both direct and alternating current.

Equipment protected throughout by double
insulation or reinforced insulation.

Operating environment:  Model Micro-C meters are Class Il (double insulated) egaipt designed
for use in Pollution Degree 2 and Installation Categb(g\er-voltage category) environments. Models
Mighty-1C and Mighty-5C do not meet this requirement.



| 5. CONNECTOR WIRING INFORMATION I

CONNECTORS

Connectors for signal and power are U/L
rated screw-clamp terminal blocks that
plug into mating jacks on the printed
circuit board. Communication connectors
are a single RJ11 plug for RS232, dual
RJ11 plugs for RS485 and dual RJ45
plugs for RS485-Modbus.

P1 - POWER AND DIGITAL CONTROLS

P1
ACHI (+DCHI) 1 i *Note: external control inputs 1 and 2 are menu
ACLO (DCRET) 2 (0L selectable.
EARTHGROUND 3| 0L
* 4 . .
CONTSSHNRFC)){T&F(LST\?* 5 g Caution: P1, pins 4, 5, and 6 may have hazardous
DIGITALGROUND 6 | OO voltages present.
PS - SIGNAL INPUT QUADRATUREINPUT (DIFFERENTIAL)
P5
DUALCHANNELPULSEINPPl.lle AINPUT  1TTEW]
P ANPUOT 2L AL
EXCITATION 1 g BINPUT 3| mm
+EXCITATION 2 BINPUT 4L
SIGNALINPUTB 3 g ZINPUT (+EXCITATION) 5[ @mm
GROUND 4 ZINPUT (-EXCITATATION) 6 XL]
SIGNALINPUTA 5| @I . e
GROUND 6L11] Note: Z input or excitation is jumper
selectable
VOLTAGE-TO-FREQUENCYCONVERTER QUADRATUREINPUT (SINGLE-ENDED)
P53
P3 Signal Source |
+AINPUT 1] (D
EXCTATION 1 I~ — = in +EXCITATION 2 /L1
+EXCITATION 2 [ B0 |- — — — —+ pre—
— ) +BINPUT  3[ i
CSIGNALINPUT 3 1 7 Lot EXCITATION 4 X1]
GROUND 6! AL}




P2 - SETPOINT CONTROLLER
DUAL MECHANICAL RELAY OUTPUTS

N/O CONTACT
ALARM 1 COMMON
ALARM 1 N/CCONTACT

ALARM 2 N/OCONTACT
ALARM 2 COMMON
ALARM 2 N/CCONTACT

ALARM 1

DA WKN =

EEE| [EEE

QUAD MECHANICAL RELAY OUTPUTS

ALARM1 N/OCONTACT
ALARM1 &2 COMMON
ALARM2 N/OCONTACT

ALARM3 N/OCONTACT
ALARM3 &4 COMMON
ALARM4 N/OCONTACT

DA WKN =

EEH||EES

P3 — SERIAL COMMUNICATIONS

RS232 INTERFACE

Computer

N/C
ISO GND

6 mmm
5

GND

RX /4 wm—

X

X 3 o

RX

RTS 2 m—

RTS

N/C 1 — I—I

RS485 INTERFACE - FULL DUPLEX

ISO GND |6 umm I GND
BRX 5w BTX
ARX 4 mmm ATX
ATX 3 - ARX
:SSB(GND 2= ARX

1 m—— GND

RS485-MODBUS - FULL DUPLEX

ISO GND [ g ]

=L

TXDO 5

GND

RXDO

TXD1 e

3
RXD1 [

RXD1

2-'_|

RXDO

TXD1

TXDO

1-|

DUAL SOLID STATE RELAY OUTPUTS

ALARM1 1| @@ — DCORAC
ALARM1 2| [@X|— NOTUSED
ALARM1 3L_IEEi— DCORAC
ALARM2 4] mm[— DCORAC
ALARM2 5| W — NOTUSED
ALARM2 6| [lll|— DCORAC

QUAD SOLID STATE RELAY OUTPUTS

ALARM1 N/OCONTACT
ALARM1 &2 COMMON
ALARM2 N/OCONTACT

ALARM3 N/OCONTACT
ALARM3 &4 COMMON
ALARM4 N/OCONTACT

DA WHKN

EEE| BEE

P4 - ANALOG OUTPUT

UNIPOLAR (SINGLE OR DUAL) AO1 AO2
4-20 mAor 0-20 mMAOUTPUT 1| mm|4
0-10V OUTPUT 2| MI|5
ISOLATED GROUND 3| [Nl |p
BIPOLAR (SINGLE ONLY) _
REFERENCE or RETURN 1 mm
-10V to +10V OUTPUT 2| @I
N/C 3 KD
RS485 INTERFACE - HALF DUPLEX
P
ISOGND |6 GND
5 mm —l—
4
ATX/ARX |3 == ATX [/ ARX
BTX/BRX |2 mmm ] BTX /BRX
ISOGND |1 mm | GND

RS485-MODBUS - HALF DUPLEX

ISO GND |8 mmm I

7
6 mmm

DO 5 =

GND

DO

D1 4 —

3
2 mmm
1 ==

D1




6. FRONT PANEL SETUP KEYS, MICRO-C & MIGHTY-1C

ALARM 1 STATUS —

P T ALARM 2 STATUS
INDICATOR / V. INDICATOR
NEGATIVE \

DISPLAYED ITEM
POLARITY INDICATOR

MENU MENU
DVAN

PEAK RESET ALARMS

\ ‘ | ALARM KEY
MENU KEY (REVERSE MENU)
PEAK DISPLAY KEY DISPLAYED ITEM &

(DIGIT SELECT) RESET KEY

Counter Front Panel

There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
PEAK, RESET, ALARMS) for the Run Mode and with symbols ( > right arrow, A up arrow,
< left arrow) for the Menu Mode.

FRONT PANEL LOCKOUT

The Menu Mode will not work with most meters shipped from the factory, since all menu
items have been disabled in software and a lockout jumper is in place. This jumper needs to
be removed for the Menu Mode to work, and values under through need to
be set to "0" via the front panel for these menu items to be available. See Section 9. The
paragraphs below assume that all lockout features have been removed.

MENU MODE KEY ACTION
In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.

KEYS IN RUN MODE

EE MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.

PEAK Key. Pressing PEAK causes the peak value of the input signal to be displayed.
w4 The peak display blinks to differentiate it from the normal present value display.
Pressing PEAK again will return the display to the present value.

/\ RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing
RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a
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RERL)

ALARMS)

meter reset (same as power on). Pressing and releasing RESET without pressing
another key, changes the displayed item if the mode has multiple items. For Item 1, the
V LED is out. For Item 2, the V LED is on. For Item 3, the V LED is flashing.

ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
again displays the setpoint for Alarm 2. Pressing it again returns to the present value.
After 30 seconds, the meter automatically returns to the present value. Timing is
automatically reset whenever the ALARMS key is pressed.

KEYS IN MENU MODE

>

PEAK

A\

RESET

RAENL
ALARMS)

Right Arrow Key (MENU). Pressing > steps the meter through all menu items that
have been enabled and then back to the Run Mode. With the dual-channel pulse input
signal conditioner board and no option boards, available menu items will be |JIIEEH.
=0 oEE SRR, etc. Actual menu items will vary depending on the Input
selection and boards detected in the meter. If a change has been made to a menu item,
that change is saved to non-volatile memory when the > key is pressed next, and

is displayed briefly.

Right Arrow Key (Digit Select).

Pressing > from the InPut menu brings up all meter functions available with the
meter's signal conditioner. For the dual-channel pulse input signal conditioner, these

) (AtE_jPEriod § totAL i_IntliStop t4 PHASERduty C}

Pressing > from most menus selections sequentially selects digit positions 1 - 6, as

T e e R AR E S Al Rete 1@ 000000M000000M0000008000000M000000§000000}

- Pressing > from dEC.Pt1 brings up a decimal point display of type (MB&KEL. Pressing
> from dEC.Pt2 brings up a decimal point display of type Y¥N¥¥yi.

Up Arrow Key (Value Select).

Pressing A from a selected meter function, such as , will select the a specific
operating mode within that function, such as [ . Always press the MENU key
to save your selection. Do not press the A key to the right, or your selection will be

lost.

Pressing A for a flashing digit position or decimal point position will increment that
item. Pressing the MENU key will save any changes.

Left Arrow Key (Reverse Menu).  Pressing < has the same effect as the MENU key,
except that menu items are brought up in reverse order.



7. SETUP KEYS, MIGHTY-5C

Display board assembly removed from case

999999

DISPLAY STATUS — @

INDICATOR
MENU KEY —/ / \ \ ALARMKEY

NEGATIVE IND. ——

(REVERSE MENU)

PEAK DISPLAY KEY VIEW DISPLAYED ITEM, RESET
(DIGIT SELECT) KEY ( VALUE SELECT)

Mighty-5C Front Panel



| 8. ENABLING & LOCKING OUT MENU ITEMS I

For security reasons and ease of operation, any and all menu items may
be disabled or "locked out" so that they are no longer directly accessible
from the front panel. Each function to be enabled is set to "0" and each
function to be disabled is set to "1" in menu items Loc 1-4. These menu
items can in turn be locked out by installing an internal hardware jumper.
With the jumper installed, the operator only has access to enabled menu
items. With the jumper removed, the operator also has access to the Loc

1-4 menu items.

SETTING HARDWARE LOCKOUT JUMPER

To access the lockout jumper, remove the rear panel per Sections 21, 22
& 23 and locate jumper “a” in the lower portion of the power supply board
next to the input connectors (see figure at right).

SETTING SOFTWARE LOCKOUTS

When setting up the meter, it may be neces-
sary to enable specific menu items by setting
the corresponding lockout digit to 0. Be sure
to reset the lockout digit to "1" if you do not
want the menu item to be changed by an
operator.

Press the > MENU key until Loc 1, Loc 2, Loc
3 or Loc 4 is displayed, as desired. Note: the
lockout jumper must be removed (see above).

111111

Press > to display the lockout status, con-
sisting of 0's and 1's. The left digit will flash.
Press > again to step to the next digit, which
will flash.

000000
123456

Press A to set the flashing digit to "0" to
enable the menu item or to "1" to disable.
Press MENU to enter. See the table to the
right for list of menu items that can be
enabled or disabled.

-10-

Enabled / Disabled Menu Items

3 - Input type selection

4 - Setup, Config, Dspyno

5 - Gate time, timeout, batch setup
6 - Filter setup

3 - Slope, decimal points

4 - Scale, offset, resolution, 2-coord.
5 - Alarm config, DevHy

6 - Alarm setpoint programming

3 - Analog output setup & scaling

4 - Serial communications configuration
5 - Calibration

6 - Change displayed Item #

3 - View peak value

4 - View alarm setpoints

5 - Front panel resets (peak & latched
alarms)

6 - Front panel reset (cold reset onlv)




| 9 DUAL CHANNEL PULSE OR AC INPUT SIGNAL CONDITIONE R I

The dual channel signal conditioner board is used for the frequency, rate, period, timing,
batch control, phase and duty cycle meter functions. The board needs to be configured via
jumpers for the input signal type and level. It is recognized by the meter software, which will
bring up the applicable menu items. The dual channel pulse input signal conditioner does

not require calibration, since the quartz crystal oscillator used for frequency and timing
applications is located on the counter main board.

|
EE..B::J B3m n = Bims 5= I
Chl B4 1
B2 m n = |
Channel B B L lI
= am mA4 A3 m m = Al 5 = I T
|
A2 s E = A0 95 = I
Channel A |

Jumper Settings for Expected Signal Levels

The jumper settings for Channel A (A2 & A3) and Channel B (B2 & B3) need to be set for
the expected signal voltage. This voltage must be outside of the high and low thresholds per
the following table, or the meter will not operate properly. The larger the difference between
the high and low thresholds, the more immune the meter is to input signal noise.

A3 | A2 Input must be A3 | A2 Input must be A3 | A2 | Input must be

B3 [ B2 | below above B3 [ B2 [ below above B3 | B2 | below | above
- a|-12mv | +12mV | a | a | +30mV | +60mV | b a | -60mVv | -30 mV
- b [-150mV |[+150mV | a | b |+350mV |+600mV | b b [-600 mV |-350 mV
- - -1.15v | +1.15V | a - +1.25V +2.1V b - -2.1V -1.25Vv

Jumper Settings for Frequency Response, Bias Resist  or, Debounce Time

Pull-up or pull-down resistors are used with open collector devices and dry contact closures
to provide input signal bias. They should not be connected for other inputs. Debounce
circuitry keeps the meter from counting extra pulses due to contact bounce.

Function Block

A0 & BO

Jumper | Setting

1 MHz max

30 kHz max

250 Hz max

10 kOhm pull-up to 5V

10 kOhm pull-down to -5V
None

3 msec

50 msec

Frequency Response

Bias Resistor Al & B1

Contact Debounce Ad & B4

(@]

O 9 o(ICoO| T
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Common Jumper Settings

Input Type Vmax AO&BO | A1&Bl1 | A2&B2 | A3&B3 | AA&B4
Logic levels 250V - - - a b
NPN open collector NA b a - a b
PNP open collector NA b b - b b
Contact closures NA aorb a - a a,
Line frequency 250V b - - - a,c
Turbine flow meter 250V b - a - b

OVERVIEW OF OPERATING MODES

RATE & FREQUENCY MODES

Frequency in Hz is determined by timing an integral number of pulses over a user-specified
gate time from 0 to 199.99 sec and taking the inverse of average period. The typical display
update rate of the meter is gate time + 1 period + 30 ms Selecting a longer gate time
produces a more stable reading as more cycles are averaged, but slows down the update
rate. At very low frequencies, the update rate is controlled by the period. A time-out from O
to 199.99 sec is also selectable. This is the time the meter waits for a signal to start or end a
conversion. If the signal is not received before the time-out ends, the meter reads zero. The
longer the time-out, the lower the minimum frequency the meter can display.

With a scale factor of 1 and multiplier of 1, frequency is displayed in Hz with no decimal
point. Appling a multiplier from 1 to 100000 (in decade steps) and setting the decimal point
increases resolution (0.1 to 0.00001 Hz). Decreasing the multiplier from 1 to 0.00001 (in
decade steps) and setting the decimal point allows display in kHz or MHz. Note that the
same 100 kHz frequency can be displayed as 100000 Hz or 100.000 kHz simply by moving
the decimal point.

DISPLAY FREQUENCY IN Hz WITH 1 Hz RESOLUTION

Dig.No.[S |1 |2 [3 |4 |5 |6 Application: Display frequency from 1 Hz
InPut r At E[A 0 n L y| to 999999 Hz with no decimal, display up-
SEtuP 00 0 0 0 date rate of 4/sec, and adaptive moving
ConFiG 10 0 0 average filter for 6 readings.
gif;m oo To g ; Solution: Set Input to “Rate A Only.” Set
- : Config to display to 999999 counts. Set
ti Out 0 0 1 0 0 : .

- Gate Time to .22 sec so that the display
FiLtEr 00 1 0 5

update rate becomes .22 sec +30 ms +1
SLOPE 0 1 , :
DecPl] ErBEECRERE period. Set Time-out to 1 sec, so that fre-
SCALET 1. 70 o [0 |0 0' 1] guencies under 1 Hz are displayed as O.
OFEST1 0o 0 0 0 0 0 Set filter for _adaptlve moving average with
—= 0 0 0 0 0 DoNetChange Calib a 1.6 sec time constant. Apply a scale

value of 1.00000 and multiplier of 1 for
direct readout in Hz.
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DISPLAY 0-50.00 RATE FROM 1-10 kHz INPUT, COORDINATE S OF 2 POINTS METHOD

Dig.No.[S |1 |2 [3 |4 |5 |6

InPut r At E|[A 0 n L v
SEtuP 00 1 0 0

ConFiG 1.0 0 0

dsPyno o 1

GAtE t 0 0 0 2 2

ti Out 0 0 1. 0 0

FiLtEr 0 0 1 0 5

SLOPE 01

DecPt1 101 1 1 1 1

Lont 0 0 1 0 0 0

Lord1 0 0 0 0 0 0

Hi In1 01 0 0 0 0

Hi rd1 0 0 5 0 0 0

CALib 0 |0 |0 |0 | 0 DoNotChange Calib

Application:  Display 0-50.00 (with two
decimal places) for 1-10 kHz input. Use
coordinates of 2 points scaling method.

Solution:  Set Input to “Rate A Only.”
Select “coordinates of 2 points” scaling
method under Setup. This is easier than
scale and offset. Set DecPtl to two places.
Then enter the low input and desired low
reading, and high input and desired high
reading, as shown.

DISPLAY RATE IN GPM FROM 36.67 PULSE/GALLON TURBINE FLOW METER

Rate in engineering units

Dig.No.[S |1 |2 [3 |4 |5 |6

InPut r At E|[A 0 n L v
SEtuP 00 1 0 0

ConFiG 1.0 0 0

dsPyno o 1

GAtE t 0 0 0 2 2

ti Out 0 0 0 1 0

FiLtEr 0 0 1 0 5

SLOPE 01

DecPt1 101 1 1 1 1

Lont 0 0 0 0 0 0

Lord1 0 0 0 0 0 0

Hi In1 0 0 3 6. 6 T

Hi rd1 0 0 6 0 0 0

CALib 0 |0 |1 |0 0 |DoeNot Change Calib

Application: Display rate in GPM to two
decimal places from flow meter calibrated
to 36.67 pulses/gallon.

Solution: Set Input to “Rate A Only. Un-
der Setup, select “coordinates of 2 points”
scaling method. Set DecPtl to two places.
Then enter the low input and desired low
reading, and high input and desired high
reading, as shown. In this example, we
want to display 60.00 (GPM) from an input
of 36.67 Hz. Note that the meter’s native
rate measurements are in Hz. There will be
60 times more gallons per minute than per
second.

is displayed from measured frequency by applying an appro-
priate scale factor and setting the decimal point. The scale factor consists of a scale value
from 0.00000 to 9.99999 (fixed decimal point and settable digits) and a scale multiplier from
0.00001 to 100000 (in decade steps). When using the coordinates of 2 points method to
scale the meter, the low input and high input frequencies are entered in Hz.

RATE A ONLY (A_OnLy) displays rate or frequency for Channel A. The latter utilizes
SCALE1, OFFStl and dECPt1. Channel B is not used.

RATE A B (A__b_ ) displays rate or frequency for Channel A as Item #1 or for Channel
B as Item #2. The latter utilizes SCALE2, OFFSt2 and dECPt2.

RATE A, TOTAL A (A _Atot) (Extended counter) displays Rate for Channel A as Item #1
and Total for Channel A as Item #2 since last reset. Total may count down from an offset
by entering a negative scale factor. Only used for non-linear inputs.

- 13-



RATE A, TOTAL B (A _btot) (Extended counter) displays Rate for Channel A as Item #1
and Total for Channel B as Item #2.

RATES A+B, A-B, AxB, A/B, A/B-1 (Extended counter) display arithmetic combinations
of Rates A and B as Item #1, Rate A as Item #2, and Rate B as Item #3. With rates A and
B scaled to produce a ratio close to 1 and an offset of -1, the special combination A/B-1,
called “Draw,” can display percentage changes, such as elongation of material as it
passes between rollers.

TOTAL MODES

DISPLAY TOTAL IN GALLONS FROM 36.67 PULSE/GALLON TU RBINE FLOW METER

Dig.No.[S [1 |2 |3 |4 |5 |6

InPut t o/t A LA 0 n L v
SEtuP 1.0 1 0 0

ConFiG 1.0 0 0

dsPyno o 1

GALE t 00 0 0 1

SLOPE 0 1

DecPt1 11 1 1.1 1

Lo In1 00 0 0 0 0

Lo rd1 0 0 0 0 0 0

Hi In1 0 0 3 6 6 7

Hi ra1 00 0 1. 0 0

CALib 0 |0 |0 |0 | 0 DoNotChange Calib

Application: Display total in gallons with
two decimal places for flow meter calibra-
ted to 36.67 pulses/gallon.

Solution: Set Input to “Total A Only.” Un-
der Setup, select “Restore totals at power-
on” and coordinates of 2 points method.
This is the preferred scaling method. Set
gate time to its minimum of 0.01 sec for
smooth display updates. Set DecPtl to two
places. Then enter low input and desired
low reading, and high input and desired
high reading for display of 1.00 for 36.67
pulses, as shown.

DISPLAY SIMULTANEOUS RATE & TOTAL FROM 36.67 PULSE/ GALLON FLOW METER

Dig. No.

6

InPurt

SEtuP

ConFiG

dsPyno

GAtEt

ti Out

FiLtEr

SLOPE

DecPt1

DecPt2?

Lo Ini

Lo rd1

HiIn1

Hi rd1
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Lo rdz2
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Hi rd2
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Application: Display flow rate in GPM with
two decimal places and total gallons with
no decimal places from the same flow me-
ter signal calibrated to 36.36 pulses/gallon,
applied to Channel A

Solution: Use an Extended counter, as
required for simultaneous rate and total.
Set Input to “Rate A A Total.” For flow rate
in GPM (Item #1), set DecPtl to two deci-
mals, and scale the display by entering Lo
In1, Lo rdl1, Hi In1, Hi rd1 as shown. For
total in Gallons (Item #2), set DecPt2 to no
decimals, and scale the display by entering
Lo In2, Lo rd2, Hi In2, Hi rd2 as shown.
Enter a Gate Time, such as 0.1 sec, which
is long enough to produce stable rate read-
ings, but is short enough to produce rapid
updates of total.



DISPLAY TOTAL VOLUME BY ADDING TWO TURBINE FLOW MET ER CHANNELS

Dig.No.[S [1 |2 |3 |4 |5 |6 Application: Display total liquid volume in
InPut t ot A L|A + b gallons to two decimal places from 2 pipes
SEtuP 1.0 1 1 0 dispensing liquids into the same tank. Flow
ConFiG 1.1 0 0 meter A is calibrated to 36.67 pulses/gal-
dSPyno 01 lon, flow meter B to 58.12 pulses/gallon.
GAtET 0000 1 Solution: Arithmetic operations require the
SLOPE 0 0

Extended counter. Apply flow meter output
DecPt1 1 1 1 1. 1 1

A output to Channel A, flow meter output B
DecPt2 2 2 2 2 2 2 y "

to Channel B. Set Input to “Total A+B.” Set
Lo In1 00 0 0 0 0 . )
Tordi 0 1o 1o To.To To Gate Time to 0.01 sec for fast display up-
Hi dates. Select a positive trigger slope for A

int 0 0 3 6 6 7 . .

HirdA 0o 0 0 1 0 0 and B. Set DecPt2, which applies to Grand
Lol 0o 0 0.0 0 0 Total, and DecPtl, whlch applies to Totals
Lordz 0o 0 0 0.0 0 A and B, both to two dec!mal places. Un_der
Hin2 0 0 5 8 1 2 Setup, select the coordinates of 2 points
Hi raz 0 0 0 1 0 0 scaling method for A and B. To scale A,
'ESoLn 1 enter 36.67 (pulses) for Hi In1 and 1.00
CALib 0 0 0 0 0 |DoNotchangecaib (gallons) for Hi Rdl. To scale B, enter

58.12 (pulses) for Hi In2 and 1.00 (gallons)
for Hi Rd2. The normal display will be Item
#1 (Grand Total). Press the A key to view
Item #2 (Total A) and Item #3 (Total B).

TOTAL A ONLY (A _OnLy) displays the number of pulses applied to Channel A as Item #1. If
scientific notation is not selected, overflows beyond 999,999 are recorded in units of 1,000,000
as Item #2. For example, a total of 17,345,676 would be displayed as 345,675 in Item #1 and
17 in Item #2. This capability gives the counter 12-digit capability. Items #1-2 can also be
retrieved via serial communications.

TOTALAB (A _b_ ) displays Total A as Item #1 or Total B as Item #2.

TOTALS A+B, A-B, AxB, A-B, A/B (Extended counter) display arithmetic combinations
of Totals A and B as Item #1, Total A as Item #2, and Total B as Item #3.

TOTAL A-B UD (A-b _Ud) is the same as TOTAL A-B, except that counts are subtracted
on an ongoing basis, instead of subtracting totals. This avoids round-off errors with large
totals.

BURST (_burST) (Extended counter) displays the total number of signal bursts applied
to Channel A as Item #1 and signal frequency within a burst as Item #2. Gate time must
be greater than the period of the lowest signal frequency and less than the minimum time
between bursts. Time-out must be greater than the maximum time between bursts.

TOTAL A B U/D (A _buU/d) (Extended counter) displays Total A as Item #1, where the up
or down count direction is determined by an input on Channel B. If the menu item SLOPE
is set to O for Channel B, (digit 6), an input level on B below the jumper set Low
Threshold B causes the count to go up, and an input level above the jumper set High
Threshold causes the count to go down. If SLOPE for Channel B is set to 1, the opposite
occurs. The maximum frequency on A that can be counted is 250 kHz, or a minimum of 4
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Hs between pulses.

TOTAL A B INHIBIT (A _binH) (Extended counter) displays Total A as Iltem #1, where
counting may be inhibited by a control input on Channel B. If the menu item SLOPE is set
to O for Channel B (digit 6), a low input level on B allows counting, and a high input level
inhibits counting. If the SLOPE for Channel B is set to 1, the opposite occurs. The
maximum frequency on A that can be counted is 1 MHz.

BATCH CONTROL MODE (_bAtCH)

BATCH CONTROL WITH A 36.67 PULSE/GALLON TURBINE FLO W METER

Dig.No.[S [1 |2 [3 [4 |5 |6 Application: Fill 55 gallon tanks, measur-
InPut r |A t E b A t ¢ H| ing flow with a 36.67 pulses/gallon flow
SEtuP 1. 00 1 0 meter. Slow down filling at 54 gallons.
ConFiG 11 0 0 Cycle batches automatically with 20 sec
dSPyno 0o 1 between cycles. Display batch total & fill
GAtE t 0 2 0.0 0 rate to 2 places. Track number of batches.
h_n reH 1,010/110 Solution: Use an Extended counter with a
FiLtEr 00 1 0 5
ElHE o o dual re!ay output board. Apply the flow
DecPtl T 1 T (111 meter signal to Channels A & B. Set Input
DecPi2 EERERERERE to “Ra_lte Batch.” Set Ba_tch to count up to
SCALET 2171217 [0 2 1] Setpointl. Use Gate Time as delay be-
OFFSt1 0o 0 0 0 0 0 tween batches. Make Item #2 the number
Lon2 0 0 0 0 0 0 of batches. Set Gate Time to 20 sec. Set
Lo rd2 0o 0 0 0.0 0 an adaptive moving average filter, which
HiInz 0.0 3 6 6 7 will apply to rate only, not totals. Set
Hi raz 0 0.6 0. 0 0 DecPtl and DecPt2 to two decimal places
'ESoLn 1 for Items #1 and #3 (Batch Total and Rate).
SourcE 11 Scale Item #1 (Batch Total) by entering a
AL SEt 0.0 2 4 0 Scalel of 2.72702 (counts per pulse) and a
dEUn1b 0 0 0 0.0 0 Setpointl of 55.00, which will serve as the
dEUnZh 0 0 0 0 0 0 batch setpoint in gallons. Scale Item #3
CALib 0 0 0 0 o0 |DoNotchangecalib (Rate) using the coordinates of 2 points

method so that 36.67 pulses/sec will be
ALARMKEY [s[1 [2 [3 |4 ]5 |6 displayed as 60.00 GPM. Set Setpoint2 to
SETPT1 00 5 4. 0 O 54.00 to activate Relay 2 to slow the fill
SETPT? g0o!l5 5 0 0 rate at 54.00 gallonS.

Batch control (Extended counter) uses the meter with a dual relay controller board to
control repetitive fill operations. Relay #1 is used as the batch relay. Relay #2 (or Setpoint
#2) can be assigned to another limit, such as pre-warn to slow filling near the setpoint, end-
of-process, or rate alarm. The same signal is applied to Channels A and B. When digit 6 of
bAtCH (Action after Meter Reset) is set to zero, the following applies:

In batch control mode without external resets, the meter waits until the RESET key is
pushed. It then energizes Relay #1 and displays the changing Batch Total. When the
preset value is reached, Relay #1 de-energizes for the duration of the gate time setting.
Relay #1 then re-energizes, the Batch Total resets, and the fill cycle repeats.
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In batch control mode with external resets, pushing the RESET key initiates cycling.
Grounding an external Gate input for a minimum of 3.33 ms then starts each new fill
cycle by energizing Relay #1 and resetting the Batch Total. Gate time is not used.

Three values are tracked and can be separately displayed by pressing the RESET key: Item
#1, the Batch Total; Item #2, the Grand Total of all batches or Number of Batches (select-
able during setup); and Item #3, the Fill Rate.

Item #1, Batch Total, is the total for that batch. It may be configured to count up from 0O to
a preset, or to count down from a preset to 0. The preset value is placed in SETPTL1.
SCALEL1 is positive whether counting up or down.

Item #2, Grand Total, is the sum of previous Batch Totals and the current Batch Total. It
can overflow to exponential format.

Item #2 (alternate), Number of Batches, is the current count of batches. SCALE1 does
not apply. dECPt1 is set to 1.

Item #3, Fill Rate, is calculated with a fixed 20 ms (or 1 cycle min) gate time. It may be
displayed as Item #3.

PERIOD MODES
PERIOD A ONLY (A_OnLy) displays period of Channel A as Item #1.

PERIODS A+B, A-B, AxB, A-B, A/B (Extended counter) display arithmetic combinations
of Periods A and B as Item #1, Period A as Item #2, and Period B as Iltem #3.

TIMING MODES

STOPWATCH TIMING, “ON” TIME OF A MACHINE WITH 0.00 HO UR RESOLUTION

Dig.No.[S |1 |2 [3 |4 |5 |6 Application:  Display daily “on” time of
InPut St o P t |A t o b | @ machine in hours with 2 decimals. For
SEtuP 1.0 1 1 0 machine maintenance, also track accu-
ConFiG 4 0 0 0 mulated hours since last reset.
dsPyno 01 Solution: Tie a relay across the AC input
gf:;; 0010 5' ; to the machine so that the r_elay closes to

ground when power is applied. Apply the
DecPt1 1 1 1 1. 1 1 )
——— > 21212 2 2 relay output across both the A & B inputs
—— 0 1o To (o [0 [0 so that the voltage is 5V when the contacts
Lordi 0 o o o0 o are open and OV when they are closed. Set
i 001316 oo Input to “Stopwatch A to B.” Select nega-
Hird1 0 0 0 1 0 0 tive trigger _slope fo_r A and positive for B.
Lon2 0o 0 0 0 0 0 Under Qonflg, set Display Mode to sec. Sgt
Lordz 00 0 0 0 0 Gate Time to _0.01 sec. Select the coordi-
HiInz 0 0 3 6 0 0 nates (_)f 2_ points scaling method for Item
Hi raz 0.0 0 0 0 1 #1 (daily time) and Item #1 (accumulated
CALID 0 0 0 0 0 |DoNotChangecaib tme). For ltem #1, set DecPtl to 2 places,

set Hi In1 to 3600 (sec) and Hi Rd1 to 1.00
(hrs). For Item #2, set DecPt2 to O places,
set Hi In2 to 3600 and Hi Rd2 to 1 (hr).
STOPWATCH TIMING, CLOSING TIME OF A RELAY TO 0.001 MSEC RESOLUTION
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Dig.No.[S [1 |2 |3 |4 |5 |6 Application: Measure the closing time of a
InPut St o P t |A t o b | relay in msec to 0.001 msec resolution.
SEE 1/0/1]1]0 Solution: To close the relay, apply the
E;"F'G 410 g (1' same positive voltage to the relay coil and
Gn':;m s oo to meter Channel A. Wire the relay so that
SLOPE ' o To OV is applied across Channel B when the

contacts are closed. Set Input to “Stop-
DecPt1 1 1 1.1 1 1 - " ;

watch A to B.” Select a positive trigger
DecPt2 2 2 2 2 2 2 . .

slope for A and a negative trigger slope for
Lo In1 0 0 0 0 0 0 ! .

B. Under Config, set Display Mode to sec.
Lo rd1 00 0.0 0 0 .
i 170 o [0 1o o Set Gate Time to 0.01 sec. Select the
Hird1 9 99909 coordinates of 2 points scaling method for
Lon2 0 0 0' 0 0 0 Item #1. Set DecPtl to 3 places. Set Hi In1
Lord? 0 0 0 0 0 0 to 1.00000 (sec) and Hi Rdl to 999.999
Hin2 0o 0 0 0 0 0 (msec). Ignore Item #2, which is not used.
Hi rd2 00 0 0 0 0
CALib 0 |0 |1 |0 0| DoHNotChange Calib

TIME INTERVAL A TO B (A _to_b) measures time between periodic inputs on Channels
A and B. Timing starts when a pulse is applied to Channel A (positive edge if slope Ais 0O,
negative edge if slope A is 1), and ends when a pulse is applied to Channel B (positive
edge if slope B is 0, negative edge if slope B is 1). Pulse width may be measured by tying
inputs A and B together and selecting a positive or negative edge to start (Slope A) and
the opposite polarity edge to stop (Slope B). If multiple start and stop pulses occur during
the gate time, the displayed value is the average of pulse widths. The value is updated at
the end of each gate time. With a scale factor of 1, one count is one microsecond.

INVERSE TIME INTERVAL (__1/Ab) (Extended counter)

Takes the inverse of time interval for a reading in /second. For example, if the average
time interval for object to travel from point A to point B is 5 seconds, the inverse time
interval would be 0.2/sec. For the average speed of the objects, simply apply a scale
factor equal to the distance separating the two points, such as 7 (inches). Speed would
then be displayed as 7 x 0.2 = 1.4 (inches/sec). For a 6-digit reading, apply a scale
multiplier of 10,000 and move the decimal point.

STOPWATCH ATO A (A_to_A) measures time between the same positive (or negative)
edge of start and stop pulses applied to Channel A. Single event times may be displayed
as Item #1 in decimal seconds, minutes or hours, or in HH:MM:SS clock format. Time is
reset to 0 when a new start pulse occurs. Accumulated total time may be displayed as
Item #2. With a scale factor of 1, one count is one microsecond.

STOPWATCH A TO B (A_to_B) measures time between a start pulse on Channel A and
a stop pulse on Channel B. Timing is the same as for A to A, except that positive or
negative edges may be selected separately for Channels A and B. This allows the pulse
width measurement of single pulses by tying Channels A and B together. One slope is
selected to start timing, and the opposite slope to stop timing.
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INVERSE STOPWATCHTIMEATOA&ATOB (__1/AA & 1/AB) (Extended counter)
Takes the inverse of stopwatch time for a reading in /second. For example, if the travel
time for an object to travel from point A to point B is 5 seconds, the inverse stopwatch
time interval would be 0.2/sec. For the speed of that object, simply multiply by a scale
factor equal to the distance separating the two points, such as 7 (inches). Speed would
then be displayed as 7 x 0.2 = 1.4 (inches/sec). For a 6-digit reading, apply a scale
multiplier of 10,000 and move the decimal point.

DUTY CYCLE MODE (duty _C) (Extended counter)

Measures ON or OFF period of periodic square waves as a percentage of total period
over a gate time which is selectable from 10 ms to 199.99 s. The same signal is applied
to Channels A and B. ON or OFF time is measured between positive and negative edges
of the signal, with averaging over multiple integral periods over the selected gate time.
Apply a scale factor of 1 for readings in percent. Apply a 10 or 100 multiplier and move
the decimal point by 1 or 2 positions for 0.1% or 0.01% resolution.

PHASE ANGLE MODE (PHASE) (Extended counter)

Measures the phase relationship in degrees between two signals with the same period
over a gate time which is selectable from 10 ms to 199.99 s, with averaging over multiple
integral periods over the selected gate time. The two signals are applied to Channels A
and B. For best accuracy, both signals should have the same amplitude. The amplitude
of sinusoidal signals should be larger that 1V, and the trigger level should be set at 12
mV (no jumper at A3 or B3, jumper a at A2 and B2).

PHASE ANGLE MEASUREMENT TO 0.01° RESOLUTION
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Dig.No.[S |1 |2 [3 |4 |5 |6 Application: Measure phase angle differ-
InPut P HA S E 1 8 0 +| ence to 0.01° resolution between two AC
SEtuP 00 1 0 0 signals centered around 0°.

ConFiG 1111010 Solution: Use an Extended counter, as
gif;m oo g ; required for phase angle measurement.
T o o (1.0 o Jumpgr_the signal conditioner for maximum
: sensitivity to catch zero voltage crossings
bAtCH 00 0 0 0 S . -
== 0 o (105 and minimize th_e effects of amplitude jitter.
—— o o Apply one AC signal to Channel A and one
DecPti EFEFECEERE to Channel _B. Set_lnput_ to “PHASE +/-
Lont 0 o lolololo 180°.” The display will be in degrees. Set a
Lordi 0o 0 0 0 0 0 gate time of 0.22 sec for 4 display updates
Hilng 1.0 0 0 0 0 per sec. Set both trigger slopes to positive.
Hi a1 0 0 0 1 0 0 Set two decimal places. Select the coordi-
ESoLn 1 nates of 2 points scaling method. Set Hi
CALib O 0 0 0 0|DoNotChangecaib N1 to 1.00000 (degrees) and Hi Rdl to

1.00 (degrees). As an alternative, select
the scale and offset scaling method. Then
simply select a scale value of 1.00000 and
a multiplier of 100.



DUTY CYCLE MEASUREMENT TO 0.01% RESOLUTION
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Application: Measure “on” period of perio-
dic pulses as a % of total period with .01%
resolution over a time interval of 100 sec.

Solution:  Phase angle measurement
requires the Extended counter. Apply the
same signal to Channels A & B. Set Input
to “Duty Cycle (A to B) / A.” The native
counts will be in percent. For a positive
“on” pulse, set trigger slope to positive for
A and negative for B. Select the coordina-
tes of 2 points scaling method. Set Hi Inl
to 1.00000 (percent) and Hi Rd1l to 1.00
(percent). As an alternative, select the
scale and offset scaling method. Then
simply select a scale value of 1.00000 and
a multiplier of 100.



SETUP OF COUNTERS WITH DUAL CHANNEL PULSE OR AC SI GNAL CONDITIONER

If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”
Menus are dynamic. Menu items will only appear if appropriate for previously made menu
selections. For example, Batch menu items will only appear if “Batch” was selected under
“Rate.” Extended counter items will only appear if “Extended” was selected under “Config.”

WS Press
> Menu

> Press Digit
PEAK Select Key

Press Value Select
Al Key

Input

Rate modes

Basic

N Rate for Channel A (Item #1). Rate for
Channel B (Item #2).

Rate for Channel A only (Item #1).

Extended meter only

oJa\i®4g] Batch control mode. Batch total (Item #1).
Grand total or number of batches (Item #2). Fill rate
(Item #3).

Rate for Channel A (Item #1). Total for
Channel A (Item #2).

Rate for Channel A (Item #1). Total for
Channel B (Item #2).

Sum of rates A & B (Item #1). Rate A
(Item #2). Rate B (Item #3).

Difference of rates A and B (Item #1). Rate
A (Item #2). Rate B (Item #3).

Product of rates A and B (Item #1). Rate A
(Item #2). Rate B (Item #3).

Rate A divided by rate B (Item #1). Rate A
(Item #2). Rate B (Item #3).

Draw, rate A/ rate B -1 (Item #1). Rate A
(Item #2). Rate B (Item #3).

Period modes

Basic

NIl Period Channel A (Item #1). Period for
Channel B (Item #2).

Period for Channel A only (Item #1).

Extended meter only

Sum of periods A and B (Item #1). Period
A (Item #2). Period B (Item #3).

Difference of periods A and B (Item #1).
Period A (Item #2). Period B (Iltem #3).

Product of periods A and B (Item #1).
Period A (Item #2). Period B (Iltem #3).

Ratio, period A divided by period B (Item
#1). Period A (Item #2). Period B (Iltem #3).
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WS Press
> Menu

> Press Digit
PEAK Select Key

Press Value Select
Al Key

(continued)

N Total for Channel A (Item #1). Total for
Total modes 2| Channel B (Item #2).
s
@ Total for Channel A only (Item #1).
Running total (Item #1) of counts on
Channel A minus counts on Channel B.
Count of bursts (Item #1). Burst frequency
(Item #2).
Total for Channel B (Item #1). Rate for
Channel A (Item #2)
>
1A _bu/d _Total for Channel A (Item #1) with up/down
5 | control via Channel B.
£ Total for Channel A (Item #1) with count
3 inhibit control via Channel B.
©
S Sum of totals A and B (Item #1). Total A
5 (item #2). Total B (Item #3).
Difference of totals A and B (Item #1). Total
A (item #2). Total B (Item #3).
Product of totals A and B (Item #1). Total A
(item #2). Total B (Item #3).
Ratio of totals A and B (Item #1). Total A
(item #2). Total B (Item #3).
O
ti Int ? Time interval (Item #1) for periodic events
Time interval mode m | with pulse signals applied to Channels A & B.
& WA\e] Inverse of time interval (/sec) (Item #1) for
W | periodic events with pulse signals applied to A & B.
Single event time (Item #1) between pulses
Stopwatch modes 2lon Channel A, or accumulated total time (Item #2).
s
i Single event time (Item #1) with pulses on
Channels A &B, or accumulated total time (Item #2).
3 WA Inverse of stopwatch time (/sec) (Item #1)
< for single events with pulse signals applied to A & A.
% iW\e] Inverse of stopwatch time (/sec) (Item #1)

for single events with pulse signals applied to A & B.
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Press
Menu

> Press Digit
PEAK Select Key

Press Value Select
Al Key

PHASE - |IEEY Span from 0°to 360° Select for phase
(continued) |Phase angle modes é angles centered around 180°(Item #1).
= Span from -180°to +180° Select for phase
W angles centered around 0°(Item #1).
. On or Off period of square waves as a
Duty cycle mode W | percentage of total period (Item #1).
SEtuP o[oJeJ8]e} Stored totals Zero totals at power-on.
Setup Restore totals at power-on.

oJo[o]o]e | eading zeros

Blank leading zeros.
Display leading zeros.

oloJo[o]e Scaling method 1

Input scale factor 1 and offset 1.
Use coordinates of 2 points method.

oloJoJo]0 Scaling method 2

Input scale factor 2 and offset 2.
Use coordinates of 2 points method.

Operation of rear connec-
tor control inputs 1 & 2.
True =logic 1 (OV or tied
to digital ground).

False = 0 (5V or open).

1 = Meter Reset*, 2 = Function Reset*

1 = Meter Reset*, 2 = Meter Hold*

1 = Meter Reset*, 2 = Peak or Valley Display*

1 = Meter Reset*, 2 = External Gate*

1 = Function Reset*, 2 = Meter Hold*

1 = Valley Only Display, 2 = Peak Only Display
1 = Function Reset*, 2 = External Gate*

1 = Meter Hold*, Peak or Valley Display*

1 = Meter Hold*, 2 = External Gate*

1 = Peak or Valley Display, 2 = External Gate*
1 = Meter Reset*, 2 = Display Blank*

1 = Function Reset*, 2 = Display Blank*

1 = Meter Hold*, 2 = Display Blank*

1 = Peak or Valley Display, 2 = Display Blank*
1 = Display Blank, 2 = External Gate*

1 = Display Item #2*, 2 = Display Item #3*

T M [T O[> oo N[ O [ NV =[O R [O JE- [O Ji- [O JE- O]

With neither 1 nor 2, or both 1 & 2, display Item #1.
1 & 2 both at OV for selections &, i, B = Function
Reset* (erases all totals). 1 & 2 both at OV for selec-

(can restore totals).
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Press
Menu

> Press Digit
PEAK Select Key

/\ Press Value Select
Tl Key

.

0000 B Normal, overload to exponential format
Configu- Display mode Normal, overload to 999999
ration 1 right-hand dummy zero
2 right-hand dummy zeros
Time display in seconds
Time display in HH.MM.SS format
B Remote display (H, K, L commands)
Single-value remote display
B Show 1 string value, slaved to another meter
 Show 2™ string value, slaved to another meter
A Show 3" string value, slaved to another meter
B Show 4™ string value, slaved to another meter
Custom Start, Stop, Skip, Show
Bl8l§ Counter mode |8 Basic counter Extended counter
Extended counter, custom curve linearization
088l Square root @ Linear rate input. Square root rate input.
Bl8 Not applicable | Setto 0.
dSPyno B Display Peak Display Valley
Display # PEAK key action Peak (1% push), Valley (2™ push)
ltem to display ltem #1* ltem #2* ltem #3*
after Meter Reset*
ANl IGJORNETS] IRQAH | Select [§ thru § for flashing digit to set gate time* in
CEICRINCAN 000.00] 000.00 seconds. Decimal point location is fixed for 10 ms
Select digit to flash. resolution.
[ATOLONele) ITOTeNele) IRIaNee | Select [§ thru g for flashing digit to set time-out* in
Time-out* 000.00§ 000.00 seconds. Decimal point location is fixed for 10 ms
Select digit to flash. resolution.
bAtCH 00000 @ Do not count extra pulses after Preset. Add
Batch setup [ Handling of overshoot Preset values to Grand Total.
count at end of batch. Count all pulses. Add Preset values to Grand
Total.
Do not count extra pulses after Preset. Add
actual Batch Totals to Grand Total.
Count extra pulses after Preset. Add actual
Batch Totals to Grand Total.
00000 § Reset batch to 0 and count up to Setpoint 1.
Count direction Reset batch to Setpoint 1 and count down.
00000 @ Use internal gate time as delay between batches
Batch triggering Use External Input B to trigger each new batch.
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LR Press > Press Digit Press Value Select
> Menu | f29%4 Select Key e Key
bAtCH 00000 @ Make Item #2 the Grand Total of all batches.
(continued) | Definition of Item #2 Make Item #2 the Total Number of batches.
00000 @ Display “rEAdy.” RESET key starts batching.
Action after Meter Reset Start batching upon Meter Reset.
00000 [ Adaptive moving average filter. Restarts filter for
Filtering Filter type high actual changes in signal.
Conventional moving average filter without reset.
00000 @ Peak* or Valley* value from unfiltered signal.
Peak & Valley filtering Peak* or Valley* value from filtered signal.
00000 @ Display value of unfiltered signal.
Display filtering Display value of filtered signal.
00000 [ Set adaptive filter for normal noise.
Adaptive filter threshold Set adaptive filter for presence of high transients.
00000 @ Nofilter 0.1 sec 0.2 sec 0.4 sec
Filter time constant 0.8 sec 1.6sec [ 3.2sec 6.4 sec
SLOPE | 00 B Positive slope
Triggering | Trigger slope, Channel A Negative slope
| 00 @ Positive slope
Trigger slope, Channel B Negative slope
dEC.Pt1 111111 1112127911 11114211 11191111 11421121 19111111
Decimal ptl | Decimal point flashes. Press A to shift the decimal point.
dEC.Pt2 222222 2 22222022 22224222 22242222 22422222 24222222
Decimal pt2 | Decimal point flashes. Press A to shift the decimal point.

Scale and Offset scaling method if selected under

SCALE1 [ONeJeLelo)e] ONaTeLelele] PNEIllele | Select [ thru [§ for flashing first digit and [§ thru §] for

Scale ONRLeJaTele] ANONeTolely) BNINOIel8 | other flashing digits. This will set the Scale Value*

Factor 1 Select digit to flash for from -9.99999 to 9.99999 with a fixed decimal point.
Scale Value. When right | Then press A to select a value from SiYeeJexl to
digit flashes, press > one |HMUY8YY in decade steps for the Scale Multiplier.
more time for the Scale |Scale Factor = Scale Value x Scale Multiplier.
Multiplier.

OFFSt1 BIOLoTeTeJe) OfeJolelels) BIJelelle | Select [ thru [§ for flashing first digit and [§ thru §] for

Offset 1 PYLeJaTale! [eIelelelale| BIslelels] | other flashing digits. Use {gJS@R¥} to set the decimal
Select digit to flash. point.

SCALE2 Scale Factor 2. Same setup process as for Scale Factor 1.

OFFSt2 Offset 2. Same setup process as for Offset 1.
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WS Press

Menu

/i

PEAK

Press Digit
Select Key

>

Press Value Select

Coordinates of 2 points scaling method if selected under

[ATOLOLOLele) GNOTSINNS Il | Select K thru [§ for flashing first digit and [§ thru g for

Low signal | RIeJeJelolel GeleleNals BIslle | other flashing digits. Move decimal point location

input 1. Select digit to flash. when flashing.

[AYOLOLOLele) GIOTSINNS Il | Select K thru [§ for flashing first digit and [§ thru g for

Reading at | S[eJoJelolel eloJals BIlefele | other flashing digits. Decimal point is fixed by

Lo Inl. Select digit to flash. dEC.Pt1

[AYOLOLOLele) GIOTSINNS IRl | Select K thru [§ for flashing first digit and [§ thru g for

High signal | BIeJeJelolel GIleleals BIelle | other flashing digits. Move decimal point location

input 1. Select digit to flash. when flashing.

[AYOLOLeLele) GIOISINNS SIIIENElE | Select K thru [§ for flashing first digit and [§ thru g for

Reading at | S[eJoJelalel lelolals BIelefele | other flashing digits. Decimal point is fixed by

Hi Inl. Select digit to flash. dEC.Pt1}

[AYOLOLeLele) GNOISINNS Il | Select K thru [§ for flashing first digit and [§ thru g for

Low signal | RIeJeJelolel GEleloals BIeIle | other flashing digits. Move decimal point location

input 2. Select digit to flash. when flashing.

Llo_rd [OYOLooo)s) [OJaTeLelels) Salele | Select K8 thru §] for flashing first digit and [§ thru § for

Reading at | S[eJoJelolel Ielolals BIeelefele | other flashing digits. Decimal point is fixed by

Lo In2. Select digit to flash. dEC.Pt1}

[ATOLOLeLele) GIONINNS Sl | Select K thru [§ for flashing first digit and [§ thru g for

High signal | RJeJoJelole] GIeJeleals BIIle | other flashing digits. Move decimal point location

input 1 Select digit to flash. when flashing.

[AYOLOLeLele) GIOIINNS Il | Select K thru [§ for flashing first digit and [§ thru g for

Reading at | RJeJoJelole] OJeJoJals BIelef8]e | other flashing digits. Decimal point is fixed by

Hi Inl. Select digit to flash. dEC.Pt1}

Preset function. Displayed for Total modes A bU/d

PrESEt [OYOLolooJs) [OJaTeLelels) Salelle | Select B8 thru §] for flashing first digit and [§ thru § for

Preset* 000000§000000§000000RESIUEIEiESlglsell[eIENd EC.Pt1 IERISCe UL CIRGE
Select digit to flash. meter counts up and reaches the Preset, it reverts to

Offsetl. When the meter counts down and reaches
Offsetl, it reverts to Preset. Set to 0 for no Preset.

Special curve offset for square root or custom curve linearization if selected under [@Jg][€;

000000§00000
00000§00000

n =]

(@)

00000

00000
elect digit to flash.

(@)

(@] (=)

Select [ thru ] for flashing first digit and [§ thru [§ for
other flashing digits. Decimal point is fixed by

dEC.Pt1}
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Scale multiplier for combinations of two channels (e.g., AxB, A/B) if selected under

Flashing 6-digit number |Press A to select. This is a multiplier R to avoid
Resolution [in decade steps from overflow or underflow of arithmetic combinations of

0.00001t(e31 00000 Channels A and B.
Quartz crystal time base calibration
CALib Time base calibration. Do not change. See Calibration section of manual.

Option dependent menu items

oSNNI [SONPLe] IS (SO[iPIl Menu items related to alarms . These

will only appear if a relay board is detected. If so, please see Section13.

Menu items related to analog output . These will only appear if an
analog output board is detected. If so, please see Section14.

Menu items related to serial communications . These will

only appear if an RS232 or RS485 1/0 board is detected. If so, please see Section 15.

Menu lockout items

Menu items used to enable or lock out (hide) other menu

items. Loc menu items may be locked out by a hardware jumper. Please see Section 9.

* See Glossary for explanation of item.

- 27-



| 10. PROCESS RECEIVER & TOTALIZER SIGNAL CONDITIONE R I

This signal conditioner board converts 0-1 mA, 4-20 mA or 0-10 V analog process signals to
a frequency signal, which is then read by the counter main board and processed
mathematically for display of rate, total (time x rate), time based on rate, or batch control.
The board needs to be configured via jumpers for the input signal range. The meter
software recognizes the board and brings up the applicable menu items for it.

Please see further manual pages for the following features: relay output (48), analog output
(51), serial communications (53), and transducer excitation output (57).

JUMPER SETTINGS |

i
Input Range Jumper Position Al _ I
0-10V None II
0-1 mA a A_1 l
4-20 mA b .@
a
|

OPERATING MODES
RATE FROM A 4-20 mA OUTPUT FLOW METER

Dig.No.[S |1 |2 |3 |4 [5 |6 Application: Display rate in GPM with 3
InPut U F 4 - 2 0|A 0 n L y]| decimal places from a 4-20 mA flow meter
SEtuP 0 0 1 0 where 4 mA = 0 GPM and 20 mA = 5.820
ConFiG 1.0 0 0 GPM.
dsPyno 0 1 . W "
FiLtEr 0 0 1.0 5 der Setup, select the coordinates of 2 points
DecPt1 11 1.1 1 1 scaling method. Under Config, select a dis-
Loin1 0 4.0 0 0 0 play of 999999 and filtering. Set the decimal
Lo rd1 0 0 0.0 0 0 point to 3 places. For scaling, set Hi Inl to
Hi In1 2 0.0 0 0 0 20.0000 and Hi Rd1 to 5.820. Set Gate Time
Hird1 0 0 58 2 0 _ to 0.22 sec, which will provide noise aver-
L 0 [0 00 0 ]DoNotChangeCallb  aqing at a display update rate of 4/sec. Also

set a 1.6 sec adaptive moving average filter,
which will process the equivalent of 6 read-
ings.

RATE MODE (Basic Counter)

Rate A accepts 0-1 mA, 4-20 mA or 0-10 V analog process signals for a process display
scaled to engineering units. Scaling is normally done using the coordinates of 2 points
method, where low and high input signals and the corresponding desired low and high
displayed values are entered. Scaling can also be done by entering scale and offset directly.
With Scalel set to 1 and Offsetl set to 0O, the full analog input range is displayed as 0
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t0100000. Measurements are averaged over a gate time, which is programmable from 10
ms to 199.99 sec. Selecting a long gate time provides a slower display update rate but
superior noise filtering. Moving average filtering is also available. Square root extraction is
selectable for use with differential pressure flow transducers. Custom curve linearization is
available with the Extended counter.

RATE & TOTAL MODE (Basic Counter)
TOTAL FROM A 4-20 mA OUTPUT FLOW METER

Application: Display Total from a 4-20 mA flow Solution: Use Extended counter. Set Input
meter where 4 mA = 0 and 20 mA =5.820 GPM. to “VF420 A A Total,” which displays Rate as
Item #1 & Total as Item #2. Under dSPyno,

Dig. No.|S | 1 [2 |3 |4 |5 |6 select Item #2 to be displayed after meter
;‘;‘:P Y E ; p 2 g A At o t]eset Set Gate Time to 0.1 sec to provide
ConFiG T T1To o fast display updates with noise averaging.

Set DecPtl to 3 places for Rate and DecPt2
dsPyno o 1
CotoFE 0 oo 110 to 2 p_Iaces for Total._Under S_etup, select the
GAET 0 0 o1 o coordinates of 2 points scaling method for
FiLtEr 0o 0 1 0 3 Rate. Set Hi In1 to 20.0000 and Hi Rd1 to
DecPtl 11 11 11 5.820. You will need to use scale & offset to
DecPt2 2 2 2 2.2 2 scale Total. Enter 1.66667 for Scale2 and a
Lot 0 4.0 0 0 0 multiplier of 0.001. That is because totalizing
Lo rd1 0 0 0.0 0 0 sums rate readings every second. Since our
HiIn1 2 0.0 0 0 0 rate is in units per minute, we have to divide
Hird1 0 0 5 8 2 0 by 60, then multiply by 0.1 for two decimal
SCALE2 1. 6 6 6 6 7 0. 0 o 1]|places. You may also enter a Cutoff such as
OFFSt2 0 0 0 0 0 0 0.010 GPM, below which zero offset errors
CALib 0 0 0 0 0 |DeNotChangecCalib and negative values will not be totalized.

Rate A, Total A allows rate to be displayed as Item #1 and total as Item #2. Scale2 and
Offset2 apply to total. Total is calculated as the product of displayed rate and time in
seconds. Since rate may be displayed in units per second, units per minute, units per hour
or other units, the total must be scaled appropriately. If rate is in units per minute, multiply
the total by 1/60. This is achieved by setting Scale2 to a scale factor of 1.66666 and a
multiplier of 0.01. If rate is in units per hour, multiply the total by 1/3600. This is achieved by
setting Scale2 to a scale factor of 2.77778 and a multiplier of 0.0001. If square root extrac-
tion or custom curve linearization (available with Extended counter) have been selected,
totalizing will be of the linearized rate readings.

BATCH CONTROL MODE (_bAtCH) (Extended Counter)

Batch control uses the meter with a dual relay controller board to control repetitive fill
operations. Relay #1 (or Setpoint #1) is used as the batch relay. Relay #2 (or Setpoint #2)
can be assigned to another limit, such as pre-warn to slow filling near the setpoint, end-of-
process, or rate alarm. The same signal is applied to Channels A and B.

In batch control mode without external resets, the meter waits until the RESET key is
pushed. It then energizes Relay #1 and displays the changing Batch Total. When the
preset value is reached, Relay #1 de-energizes for the duration of the gate time setting.
Relay #1 then re-energizes, the Batch Total resets, and the fill cycle repeats.

In batch control mode with external resets, the meter waits a the end of every cycle
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until an external Function Reset input is grounded for a minimum of 3.33 ms. This starts a
new fill cycle by energizing Relay #1 and resetting the Batch Total. Gate time is not used.

Three values are tracked and can be separately displayed by pressing the RESET key: Item
#1, the Batch Total; Item #2, the Grand Total of all batches or Number of Batches (select-
able during setup); and Item #3, the Fill Rate.

ltem #1, Batch Total,

is the total of input pulses for that batch. It may be configured to
count up from O to a preset, or to count down from a preset to 0. The preset value is
placed in ALARM1. SCALEL1 is positive whether counting up or down.

Item #2, Grand Total, is the sum of previous Batch Totals and the current Batch Total. It
can overflow to exponential format.

Item #2 (alternate), Number of Batches,

not apply. dECPt1 is set to 1.

is the current count of batches. SCALE1 does

Item #3, Fill Rate, is calculated with a fixed 20 ms (or 1 cycle min) gate time. It may be

displayed as Item #3.

BATCH CONTROL WITH A 4-20 mA OUTPUT FLOW METER

Dig.No.|S [1 [2 [3 [4 |5 |6

InPut
SEtuP
ConFiG
dsPyno
CutoFF 0
GATEt
bAtCH
FiLtEr
SLOPE
DecPt1
DecPt2
SCALE1
OFF5t1
Lo In2
Lo rd2
Hi In2
Hirdz2
rESoLn
Sourck
AL SEt
dEUNn1hb
dEUNn2hL
CALIb

1

=R — ]

S e e sN-

I
0
1

[—NE—RN. R —]

W o oo NS N -

A
0
1

I

o P e e M~

1

oo -

N o oo oS N =00 -0

E

- 0000 SN - N2 -

[—HR—NE—R—]

b A t C HJ

0. 0 1

D Mot Change Calib

Al ARMKEY

| 6

SETPT2

S|

asla]le 2s e

mip| == = 2 =

alw|= 2|2 M=
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Application:  Fill 55 gallon tanks. Use a
4-20 mA flow meter where 4 mA = 0 and 20
mA = 39.20 GPM. Slow down filling at 54
gallons. Cycle batches automatically with 20
sec between cycles. Display batch total & fill
rate to 2 places. Also track number of
batches.

Solution: Use an Extended counter with
a dual relay output board. Set Input to “Rate
Batch.” Set Batch to count up to ALARM1, to
use Gate Time as delay between batches,
and to make Item #2 the number of batches.
Set Gate Time to 20 sec. Set DecPtl and
DecPt 2 to two decimal places for Items #1
and #3 (Batch Total and Rate). Scale Item
#3 (Rate) using the coordinates of 2 points
method so that 20.0000 mA will be displayed
as 39.20 GPM. Scale Item #1 (Batch Total)
by entering a Scalel of 1.66667 and a mul-
tiplier of 0.01. That is because totalizing
sums readings in gallons every second.
Since our rate is in GPM, we have to divide
by 60. Enter an Offsetl of 55.00to serve as
the batch setpoint in gallons. Set Setpoint2
to 54.00 to activate Relay 2 to slow the fill
rate.



1/RATE MODE (Extended Counter)

An example of 1/Rate is the time it takes an item takes to travel through an oven at a
measured rate. Like Rate, 1/Rate can be scaled using Scalel and Offsetl. With no offset
and Scalel set to 1, Rate A for the full analog input range will be displayed as 0-100000,
and 1/A will be displayed as 1000000/A. Both the A and 1/A readings are multiplied by
Scalel and offset by Offsetl. With Scalel set to 1, A is displayed as 10000, and 1/A is
displayed as 100. With Scalel set to 2, A is displayed as 20000, and 1/A is displayed as
200. If square root extraction is applied to rate, the rate display A is replaced by O , and
1/A is replaced by 1/0 . 1/A does not apply to custom curves.

Scaling may also be done by using the coordinates of 2 points method, which automatically

calculates scale and offset for the displayed value when the low and high input signals and
the corresponding desired low and high displayed values are entered.
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KEYSTROKES FOR SETUP

If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”
Menus are dynamic. Menu items will only appear if appropriate for previously made menu
selections. For example, Batch menu items will only appear if “Batch” was selected under
“Rate.” Extended counter items will only appear if “Extended” was selected under “Config.”

Press
Menu

> Press Digit
PEAK Select Key

Press Value Select
Al Key

- ecalo it |2 Rate for Channel A (Item #1).
Pt ] Hi-scee inp § Rate for Channel A (Item #1). Total for
\VF4-20 Channel A (Item #2).
4-20 mA full-scale
input T i8] Batch control mode. Batch total (ltem #1).
5 | Grand total or number of batches (Item #2). Fill rate
VE_0-1 ) G | (Item #3).
0-1 mA full-scale input| %
- 1/Rate for Channel A (Item #1).
SEtuP 000_0 Zero totals at power-on.
Setup Stored totals Restore totals at power-on.
000 O Blank leading zeros.
Leading zeros Display leading zeros.
000 O Input scale factor 1 and offset 1.
Scale factor 1 setup Use coordinates of 2 points method.

000
Operation of rear connec-
tor inputs 1 & 2.
True =logic 1 (OV or tied
to digital ground).
False =0 (5V or open).

!

1 = Meter Reset*, 2 = Function Reset*

1 = Meter Reset*, 2 = Meter Hold*

1 = Meter Reset*, 2 = Peak or Valley Display*
1 = Meter Reset*, 2 = External Gate*

1 = Function Reset*, 2 = Meter Hold*

1 = Valley Only Display, 2 = Peak Only Display
1 = Function Reset*, 2 = External Gate*

1 = Meter Hold*, Peak or Valley Display*

1 = Meter Hold*, 2 = External Gate*

1 = Peak or Valley Display, 2 = External Gate*
1 = Meter Reset*, 2 = Display Blank*

1 = Function Reset*, 2 = Display Blank*

1 = Meter Hold*, 2 = Display Blank*

1 = Peak or Valley Display, 2 = Display Blank*
1 = Display Blank, 2 = External Gate*

1 = Display Item #2*, 2 = Display Item #3*

With neither 1 nor 2, or both 1 & 2, display Item #1.
1 & 2 both at OV for selections &, i, B = Function
Reset* (erases all totals). 1 & 2 both at OV for selec-

[T M T [O [0 [3> O o N[ OB [ [NV =[O RNIE [O JE- [O JE- [O)]

(can restore totals).
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Press
Menu

> Press Digit
PEAK Select Key

/\ Press Value Select
ol Key

.

B Normal, overload to exponential format
Configura- [Display mode Normal, overload to 999999
tion 1 right-hand dummy zero
2 right-hand dummy zeros
Time display in seconds
Time display in HH.MM.SS format
B Remote display (H, K, L commands)
Single-value remote display
B Show 1 string value, slaved to another meter
[ Show 2" string value, slaved to another meter
A Show 3™ string value, slaved to another meter
B Show 4" string value, slaved to another meter
Custom Start, Stop, Skip, Show
@ Basic counter
Counter mode Extended counter
Extended counter, custom curve #1 selected
Extended counter, custom curve #2 selected
B Linear rate input.
Linearization mode Square root rate input.
[ Do not totalize rate values below value.
Rate cutoff enable for (avoids totalizing small offsets from O rate value
totalizing or negative rate values).
Totalize all rates (required for bidirectional flow).
@ Display Peak
Display # |PEAK key action Display Valley
Peak (1% push), Valley (2™ push)
ltem #1*
Item to display after Item #2*
Meter Reset* ltem #3*
MIElY | Select [§ thru g for flashing digits. In A_Atot or Batch
Totalizing modes, meter will not totalize rate values below this
cutoff* Select digit to flash. cutoff to avoid totalizing small offsets from zero.
AN | Select [§ thru [g for flashing digit to set gate time* in
Gate time* seconds. Decimal point location is fixed for 10 ms
Select digit to flash. resolution. This is time over which rate is measured.
RIS | Select [§ thru [§ for flashing digit to set timeout* in
Timeout* seconds. Decimal point location is fixed for 10 ms

Select digit to flash.

resolution. This is time during which batch relay is

de-energized at the end of a batch cycle.
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Press
Menu

> Press Digit
PEAK Select Key

/\ Press Value Select
Al Key

bAtCH 00000gs® 00000 B Not used with VF Batch. Set to 0.
Batch setup 00000 @ Use gate time* as delay between batches.
Batch triggering Use External Input B to start each new batch.
00000 @ Make Item #2 the Grand Total of all batches.
Definition of Item #2 Make Item #2 the Total Number of batches.
00000 @ Display “rEAdy.” RESET key starts batching.
Action after Meter Reset Start batching upon Meter Reset.
00000 [ Adaptive moving average filter. Restarts filter for
Filtering Signal filtering high actual changes in signal.
Conventional moving average filter without reset.
00000 § Peak* or Valley* value from unfiltered signal.
Peak & Valley filtering Peak* or Valley* value from filtered signal.
00000 @ Display value of unfiltered signal.
Display filtering Display value of filtered signal.
00000 [ Set adaptive filter for normal noise.
Adaptive filter setup Set adaptive filter for presence of high transients.
00000 @ Nofilter 0.1 sec 0.2 sec 0.4 sec
Filter time constant 0.8 sec 1.6sec [ 3.2sec 6.4 sec
dEC.Pt1 111111 1112127911 11114211 11191111 11421121 19111111
Decimal ptl | Decimal point flashes. Press A to shift the decimal point.
dEC.Pt2 2 22222 2. 22222022 22224222 22242222 22422222 24222222
Decimal pt2 | Decimal point flashes. Press A to shift the decimal point.

Scale and Offset scaling method if selected under

SCALE1 [ONeLeLeloJe] ONaTelelele] PNEIlelele | Select [ thru [§ for flashing first digit and [§ thru §] for
Scale 0.00000J0.00000§0.00000) other flashing digits. This will set the Scale Value*
Factor 1 Select the digit to flash from -9.99999 to 9.99999 with a fixed decimal point.
for the Scale Value, then |Then press A to select a value from SXe[e[e[exl to
press > one more time ((e[0]00]o) in decade steps for the Scale Multiplier.
for the Scale Multiplier Scale Factor = Scale Value x Scale Multiplier.
OFFSt1 [OYOJooo)s) [OJTeLelels) Salele | Select K8 thru §] for flashing first digit and [§ thru § for
Offset 1 000000J000000j000000 other flashing digits. Use s|=(@} ¥} to set the decimal
Select digit to flash. point.
SCALE2 Scale Factor 2. Make the same Scale Factor 1.
OFFSt2 Offset 2. Make the same as for Offset 1.
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WS Press
> Menu

Py Press Digit Press Value Select
[

ve Select Key ol Key

Coordinates

of 2 points scaling method if selected under

[ATOLOLeLele) GIOTSINNS SRRl | Select K thru [§ for flashing first digit and [§ thru g for
Low signal | RJeJoJelole] GIeleleels BIIle | other flashing digits. Move decimal point location
input 1. Select digit to flash. when flashing.

[ATOLOLeLele) GNOISINNS IRl | Select K thru [§ for flashing first digit and [§ thru ] for
Reading at | RJeJoJelole] OJeJoJels BIelef]el | other flashing digits. Decimal point is fixed by

Lo Inl. Select digit to flash. dEC.Pt1}

[AYOLOLOLele) GIOISINNS IRl | Select K thru [§ for flashing first digit and [§ thru ] for
High signal | RJeJoJelole] GIeJeleels BIle | other flashing digits. Move decimal point location
input 2. Select digit to flash. when flashing.

[AYOLOLOLele) GNOISINNS IRl | Select K thru [§ for flashing first digit and [§ thru g for
Reading at | JeJoJelole] OJeloJels BIslef]8l | other flashing digits. Decimal point is fixed by

Hi In2. Select digit to flash. dEC.Pt1}

Special curve offset for square root or custom curve linearization if selected under [@JgI[€

[OTOJoJoJoNs) [OJTeLelels) SIJalele | Select B8 thru §] for flashing first digit and [§ thru § for
PIIeTaleNe) SIellelalel Gleslel) | other flashing digits. Decimal point is fixed by
Select digit to flash. dEC.Pt1}

Scale multiplier

Flashing 6-digit number |Press A to select. This multiplier R appears with the

Resolution [in decade steps from Batch mode and can be applied to Grand Total to

0.00001t(e}100000 set its decimal point.

Quartz crystal time base calibration

Time base calibration. Do not change. See Calibration section of manual.

Option dependent menu items

oSN SONPAR ISV (S8l  Menu items related to alarms . These

will only appear if relay board is detected. If so, please see Section 13.

Menu items related to analog output . These will only appear if an
analog output board is detected. If so, please see Section14.

Menu items related to serial communications . These will

only appear if an RS232 or RS485 1/0 board is detected. If so, please see Section 15.

Menu lockou

t items

Menu items used to enable or lock out (hide) other menu

items. Loc menu items may be locked out by a hardware jumper. Please see Section 9.
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| 11 QUADRATURE SIGNAL CONDITIONER I

Quadrature Channel A ‘
Quadrature Channel B ‘

Zero Index Channel

ZeroIndex Channel
ARDed with A and B

The quadrature signal conditioner board can be used for quadrature position (with Basic or
Extended main board) or for quadrature rate (with Extended main board). Two quadrature
signals, which are 90° out of phase, are applied to the Channel A and B inputs. Their phase
relationship determines whether the count is up (+) or down (-). A zero index signal may be
applied to Channel Z as a position reference.

Position in engineering units  is determined by adding or subtracting transitions, as deter-
mined by the signal phase relationship, applying a programmable scale factor to the total,
and adding programmable Offsetl to the scaled total. The display update rate is set by a
gate time, which is programmed to 10 ms. When the scaled total reaches a programmable
Preset, it is reset to Offset 1.

Rate in engineering units is determined by measuring Rate A and Rate B in transitions per
second for Channels A and B, subtracting Rate B from Rate A, and applying a scale factor.
Rate is measured over a gate time, which is programmable from 10 ms to 199.99 sec. Since
one of the two channels may not be measuring any pulses over the gate time, a timeout
from 10 ms to 199.99 sec is also programmable. The meter update rate will never be less
than every timeout. Quadrature rate provides a high resolution, high accuracy display.

A zero index function is available to zero the counts in the event of a pulse on a separate
zero index channel. This function utilizes the programmable Pulses* item. This is the
number pulses between zero index marks x the edges per pulse (1, 2 or 4) x the scale
factor. Since a wide zero index pulse could cause a count discrepancy in the region
between transitions, the zero index pulse can be shaped by an AND combination with the A
or B channels, as set by jumpers. Please see the diagram at the top of this page, which
shows an AND combination of the zero index channel, Channel A and Channel B.

Please see further manual pages for the following features: relay output (48), analog output
(51), serial communications (53), and transducer excitation output (57).
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Jumper Settings

E9 ES

H N

O

iy
E10
s
R X

[a]

E2 .E.E.E. 1t

E7
E3a,

2k

E4|.E..-E|

EGIIIllIl@
[b ] E5

%F

Input Type E2 E4 E6 ES
Single-ended (signal & return) a,c|ac|ac Cc
Differential b b b C
Differential (with excitation and no zero index) b b - b, d
Input Termination (for differential inputs only) El E3 ES
For long cable runs a a a
For short cable runs none none | none
Phase for Up Count E7

A positive, negative B transition (A leads B) none

A positive, positive B transition (B leads A) a

Count-by Options E9

X1 = positive edge of A input none

X2 = positive & negative edges of A input a

X4 = positive & negative edges of A & B inputs b

Zero Index Polarity E8

Positive C

Negative none

Zero Index ANDing E10 ES8
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Zero Index (no ANDIng)
Zero Index AND /A

Zero Index AND /B

Zero Index AND A

Zero Index AND B

Zero Index AND /A AND /B
Zero Index AND /A AND B
Zero Index AND A AND /B
Zero Index AND A AND B

TOTOTOTO® OO0
®
o

PROGRAMMING EXAMPLE FOR QUADRATURE TOTAL :
DISPLAY DISTANCE TO 0.001 FT FROM A 1024 PULSE/REV QUADRATURE ENCODER

Dig.Mo.[S |1 |2 [3 |4 |5 |6

InPut q u A ld T t o t A L|
SEtuP o 0 1|0 0

ConFiG 1 0 0|0

dSPyno 01

PULSES (0 1 |0 2 4.

GATEt 0 0 01 0

DecPti 1 1 1. 1 1 1

Lo Int o 0 0 0 0 0

Lo rdt 0o 0 00 0 0

Hiln1 0o 1 0 2 4. 0

Hi rd1 o 0 1. 7 8 2

CALib 0 0 0 © 0 | DoMNotChange Calib

Application: Display distance in feet with 3
decimal points using a 1024 pulse/revolution
guadrature encoder tied to a roller with 1.782
ft circumference.

Solution: Set Input to “Quadrature Total.”
Set Gate Time to 0.01 sec for fast display
updates. Set DecPtl to 3 places. Under
Setup, select coordinates of 2 points scaling
method. Set Hi Inl to 1024.0 (pulses) and
the desired Hi Rd1 to 1.782 (feet).

KEYSTROKES FOR SETUP OF QUADRATURE TOTAL
If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

WS Press
> Menu

Press Digit

473 Sclect Key

Press Value Select

2ol Key

Basic meter | [ Quadrature total (select for position)
Input uadrature
P Q Extended Quadrature rate.
SEtuP 0[0[8[8]0) Stored totals Zero all totals at power-on
Setup Restore totals at power-on. Set [8]BS]=] to O.

oJo[o]o]e | eading zeros

Blank leading zeros.
Display leading zeros.

oloJolo]e Scaling method

Input scale factor 1 and offset 1
Use coordinates of 2 points method

0]e]0]8]0) Not applicable

O il [OR- [OJE- [O]

Set to 0.
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Operation of rear connec-
tor inputs 1 & 2.

True =logic 1 (OV or tied
to digital ground).

False =0 (5V or open).

1 = Meter Reset*, 2 = Function Reset*

1 = Meter Reset*, 2 = Meter Hold*

1 = Meter Reset*, 2 = Peak or Valley Display*
1 = Meter Reset*, 2 = External Gate*

1 = Function Reset*, 2 = Meter Hold*

1 = Function Reset*, 2 = External Gate*

1 = Meter Hold**, Peak or Valley Display**
1 = Reset Total A**, 2 = Reset Total B**

1 = Force Alarml, 2 = Force Alarm2

1 = Meter Reset*, 2 = Display Blank*

1 = Function Reset*, 2 = Display Blank*

1 = Meter Hold*, 2 = Display Blank*

|[@) [s21 p=) =1 [s=1 N1 [+21 (%21 ENY [¥%]1 1 [ =]

Operation of rear connec-
tor inputs 1 & 2.

True =logic 1 (OV or tied
to digital ground).

False =0 (5V or open).

D

1 = Display Blank, 2 = External Gate*

@ 1 =Display Item #2, 2 = Display Item #3
With 1 and 2 at 5V or open, Display Item #1.

* 1 & 2 both at OV = Meter Reset (can restore
totals).

* 1 & 2 both at 0V for selections B, i, B, ® =
Function Reset* (erases all totals).

I8 Display mode | Normal, overload to exponential format
Configura- Normal, overload to 999999
tion Normally select fll, required for Preset function. See
dual signal conditioner for other available modes.
ojolo]y Counter type @ Basic counter (use for quadrature total)
Extended counter
B8]y Square root ] SettooO.
{8 V-to-F batch [ SettooO.
dSPyno R tem # [l Setto 0 (ignored for Quadrature Total).
Display H Response to B Peak
PEAK pushbutton Valley
Peak (1% push), Valley (2" push)
PULSES foTololele] ISTeTelele) IRIOJelsl8 | Select [§ thru [§ for flashing digit to set zero index
Zero index 00000}] 00000 pulses. This should pulses per revolution x edges
pulses* Select digit to flash. per pulse (1, 2 or 4) x scale factor.
ATOLONeNs] IJOTONele) IRIJeNe) | Select [§ thru [§ for flashing digit to set the display
LRI 000.00] 000.00 update rate from 10 ms to 199.99 s.

Select digit to flash.
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1 = Valley Only Display**, 2=Peak Only Display**

1 = Peak or Valley Display**, 2 = Display Blank**




dEC.Pt1
Decimal ptl

111111

Decimal point flashes.

Press A to shift decimal point.

Scale and Offset scaling method if selected under

SCALE1
Scale
Factor 1

0.00000J0.00000§0.00000
0.00000J0.00000§0.00000

Select the digit to flash
for the Scale Value, then
press > one more time
for the Scale Multiplier.

Select [ thru ] for flashing first digit and [§ thru [§ for
other flashing digits. This will set the Scale Value*
from -9.99999 to 9.99999 with a fixed decimal point.
Then press A to select a value from to

in decade steps for the Scale Multiplier.
Scale Factor = Scale Value x Scale Multiplier.

Offset 1

000000§000000g000000

0

i

o

00000j000000
elect digit to flash.

wn

Select ¥ thru ] for flashing first digit and [§ thru § for
other flashing digits. s]=(ef¥l is used for decimal
point.
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Press
Menu

Press Digit
PEAK Select Key

N

Press Value Select

Coordinates

of 2 points scaling method if selected under

[ATOLOLOLele) GNOISINNS Il | Select K thru [§ for flashing first digit and [§ thru g for
Low signal | RJeJoJelole] GIeleleels BIeIle | other flashing digits. Move decimal point location
input 1 Select digit to flash. when flashing.
[AYOLOLOLele) GNOTSINNS IRl | Select K thru [§ for flashing first digit and [§ thru g for
Reading at | SJeJoJolele] SIeJJools) BIelslslef8 | other flashing digits. [s]SeRdu is used for decimal
Lo Inl. Select digit to flash. point.
[AYOLOLOLele) GIOTSINNS Il | Select K thru [§ for flashing first digit and [§ thru g for
High signal | JeJoJelole] GIeJeleele BIIle | other flashing digits. Move decimal point location
input 2. Select digit to flash. when flashing.
[ATOLOLOLele) GIOISINNS IRl | Select K thru [§ for flashing first digit and [§ thru g for
Reading at | JeJoJelole] OJeJoJels BIelef]e | other flashing digits. Decimal point is fixed by
Hi In2. Select digit to flash. dEC.Pt1}
PrESEt [OYOooo)s) [OJTLelels) Salele | Select K8 thru §] for flashing first digit and [§ thru § for
Preset* PLLeJaTale! EIelelelale| BIleNels] | other flashing digits. g]SeN¥Y is used. When the
Select digit to flash. meter counts up and reaches the Preset, it reverts to
Offsetl. When the meter counts down and reaches
Offsetl, it reverts to Preset. Set to 0 for no Preset.
CALib Time base calibration Not applicable to Total. Do not change value!

Option-dependent menu items

o|SOJokNs] SLlo] [SS[NG (SS[Pil Menu items related to alarms .

These will only appear if a relay board is detected. If so, please see Section13.

Menu items related to analog output . These will only appear if
an analog output board is detected. If so, please see Section14.

Menu items related to serial communications . These will
only appear if an RS232 or RS485 1/0 board is detected. If so, please see Section 15.

Menu lockout items

Menu items used to enable or lock out (hide) other menu

items. Loc menu items may be locked out by a hardware jumper. Please see Section 9.

* See Glossary for explanation of item.
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PROGRAMMING EXAMPLE FOR QUADRATURE RATE:
DISPLAY RATE TO 0.001 FT/SEC FROM A 1024 PULSE/REV QUADRATURE ENCODER

D¥ig. Mo.

s|1|2|3]4]5]6

InPut

SEtuP

ConFiG

dsPyno

GAtE t

ti Out

FiLtEr

DecPt1

DecPt2

La In1

Lo rd1

Hiln1

Hird1

Lo In2

Lo rid2

Hi In2

Hird2

rESolLn

CALib

oo oo oo o Ok -=

q
0

=R NE—RE—NE—R N — R — RS RN — R — R —)

(=]

u
0
1

(=]

= o oo 2o N= o oo

A
1
1

(=]

A AR RN NRF- Ry Ry

d

(=]

(=R NN R —RE—RE—R SRR — R — R — R SR N — R — R R — R —]

Application: Display rate in feet/sec with 3

r A t E|decimal points using a 1024 pulse/revolution

Do Not Change Calib
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guadrature encoder tied to a roller with 1.782
ft circumference. Have 4 display updates per
second.

Solution: Set Input to “Quadrature Total.”
Set Gate Time to .22 sec so that the display
update rate becomes .22 sec +30 ms +1
period. Set Time-out to 1 sec, so that pulse
rates under 1 Hz are displayed as 0. Set
both DecPtl and DecPt2 to 3 places. Under
Setup, select coordinates of 2 points scaling
method. Set both Hi In1 and Hi In2 to 1024.0
(pulses/sec) and both the desired Hi Rdl
and Hi Rd2 to 1.782 (feet/sec). Note: the
duplicate entries are required because the
guadrature meter subtracts counterclockwise
pulses from clockwise pulses.



KEYSTROKES FOR SETUP OF QUADRATURE RATE
If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

WS Press
Menu

> Press Digit
PEAK, Select Key

Press Value Select
reseT MG

Basic meter Quadrature total
Input ratur
Pu Quadrature | o nded Quadrature rate
SEtuP Il Not applicable |8 Set to zero.
t . .
Setup 8 Leading zeros |[§§ Blank leading zeros.
Display leading zeros.
pIOllls) Scaling Method 1 |[§§ Input scale factor 1 and offset 1
Use coordinates of 2 points method
ofefe]ele) Scaling Method 2 | Make the same as Scaling Method 1
00000 [ 1= Meter Reset*, 2 = Function Reset*
Operation of rear connec- 1 = Meter Reset*, 2 = Meter Hold*
tor inputs 1 & 2. 1 = Meter Reset*, 2 = Peak or Valley Display*
True = logic 1 (OV or tied 1 = Meter Reset*, 2 = External Gate*
to digital ground). 1 = Function Reset*, 2 = Meter Hold*
False = 0 (5V or open). 1 = Valley Only Display, 2 = Peak Only Display
B 1 =Function Reset*, 2 = External Gate*
1 = Meter Hold*, Peak or Valley Display*
B 1= Meter Hold*, 2 = External Gate*
® 1=Peakor Valley Display, 2 = External Gate*
A 1= Meter Reset*, 2 = Display Blank*
[} 1 =Function Reset*, 2 = Display Blank*
1 = Meter Hold*, 2 = Display Blank*
B 1=Peakor Valley Display, 2 = Display Blank*
1 = Display Blank, 2 = External Gate*
1 = Display ltem #2, 2 = Display tem #3*
With neither 1 nor 2, or both 1 & 2, display Iltem #1.
1 & 2 both at OV for selections §, i, B = Function
Reset* (erases all totals). 1 & 2 both at OV for selec-
tions, M, B, & B 8 B I B @ E = Meter Reset*
(can restore totals).
8§ Display mode |8 Normal, overload to exponential format
Configura- Normal, overload to 999999
tion Normally select ll, required for Preset function. See

dual signal conditioner for other available modes.

Bl Counter mode |8 Basic counter

Extended counter (required for Quadrature Rate)
Bl Not applicable |§ Setto 0.
B8  Not applicable |[§ Setto 0.
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Press
Menu

> Press Digit
PEAK Select Key

Press Value Select

n

dSPyno PEAK key action |§] Display Peak Display Valley
Display # Peak (1% push), Valley (2™ push)
ltem to display ltem #1* (Quadrature Rate = Rate A - Rate B)
after Meter Reset Item #2* (Rate A) Item #3* (Rate B)
GALE t [aToloNle] ISJoToXele) ISJeIoNels) | Select [§ thru [ for flashing digit to set gate time* in
Gate time* 000.00] 000.00 seconds. Decimal point location is fixed for 10 ms
Select digit to flash. resolution.
[ALOLONele) ITOTeNele) IRIaNeE | Select [§ thru g for flashing digit to set time-out* in
Time-out* 000.00§ 000.00 seconds. Decimal point location is fixed for 10 ms
Select digit to flash. resolution.
00000 [ Adaptive moving average filter. Restarts filter for
Filtering Signal filtering high actual changes in signal.
Conventional moving average filter without reset.
00000 @ Peak* or Valley* value from unfiltered signal.
Peak & Valley filtering Peak* or Valley* value from filtered signal.
00000 @ Display value of unfiltered signal.
Display filtering Display value of filtered signal.
00000 [ Set adaptive filter for normal noise.
Adaptive filter setup Set adaptive filter for presence of high transients.
00000 @ Nofilter 0.1 sec 0.2 sec 0.4 sec
Filter time constant 0.8 sec 1.6sec [ 3.2sec 6.4 sec
dEC.Pt1 111111 1121227911 1111422121 11191111 1142212121 19111111
Decimal ptl | Decimal point flashes. Press A to shift decimal point of reading.
dEC.Pt2 2 22222 Make the same as {o]lORZ ¥k
Decimal pt2 | Decimal point flashes.

Scale and Offset scaling method if selected under

SN | Golelelele) GNeTeLelels) SHOIIElE | Select K thru [ for flashing first digit and [§ thru [§ for
Scale ONRTeJaTele] ANONeTolely) BNINOIel8 | other flashing digits. This will set the Scale Value*
Factor 1 Select the digit to flash from -9.99999 to 9.99999 with a fixed decimal point.
for the Scale Value, then |Then press A to select a value from S¢[e[eekl to
press > one more time efejele]o) in decade steps for the Scale Multiplier.
for the Scale Multiplier. Scale Factor = Scale Value x Scale Multiplier.
OFFSt1 [OTOJoooNs) [OJeTeLelefs) Salelle | Select B8 thru §] for flashing first digit and [§ thru § for
Offset 1 [oJeJoJoNe]e) lelelelole) BIeffeleldl | other flashing digits. Use [s|ON ¥ to set the decimal
Select digit to flash. point.
SCALE?2 Scale Factor 2 Make the same as S]eJA\R=xN.
OFFSt2 Offset 2 Make the same as [@IggSiul.
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WS Press

Menu

v
N

Press Digit
PEAK Select Key

Press Value Select

of 2 points scaling method if selected under

Lo _Inl

i
!

00000§00000
000000J00000

(@)
(@)

Select [ thru ] for flashing first digit and [§ thru [§ for
other flashing digits. Move decimal point location

Select digit to flash. when flashing.

0 [OYOLooo)s) [OJTeLelels) SIalele | Select K8 thru §] for flashing first digit and [§ thru § for
PILeTaleNe) SIellelalel Gleelel) | other flashing digits. Decimal point is fixed by
Select digit to flash. dEC.Pt1}

Hi Inl [OYOooo)s) [OJTeLelels) Salle | Select K8 thru §] for flashing first digit and [§ thru § for
RILOTaLeN8) BIeNleNalel Gleslel) | other flashing digits. Move decimal point location
Select digit to flash. when flashing.

Hi rd1 [OYOLooo)s) [OJTeLelels) Salele | Select K8 thru §] for flashing first digit and [§ thru § for

000000§000000j00000
Select digit to flash.

(@)

other flashing digits. Decimal point is fixed by
dEC.Pt1}

Lo _In2

) S5 T — O 5= O

= o T o © o © 2 o)
—_ Q

o — > o — =

= 2 e — %) o

«Q TQ Q = % 8
>

2 5] 2 =3 @

Low signal input 2.

Make the same as

—
o
=
o
N

Reading at Lo In2

Make the same as

Hi_In2

High signal input 2

Make the same as

Hi_rd2

Reading at Hi In2.

Make the same as

parameters

,
M| 2
)| = |
QD
o = D
=15 I
« D
c
©

Flashing 6-digit number
in decade steps from

Press A to select a decade multiplier R for the rate
reading. Setto 1.

multiplier 0.00001te3100000
CALib Time base calibration Do not change. See Calibration section of manual.

Option dependent menu items

oSN JEVNPASR ISV (S[PIll  Menu items related to alarms if a

relay board is detected. If so, please see Section13.

Menu items related to analog output if an analog output board is
detected. If so, please see Sectionl14.

Menu items related to serial communications

if a serial

board is detected. If so, please see Section 15.

Menu lockout items

Menu items used to enable or lock out (hide) other menu

items. Loc menu items may be locked out by a hardware jumper. Please see Section 9.
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| 12. SERIAL INPUT METER / REMOTE DISPLAY OPERATION I

With a Basic counter main board and a serial interface board, the counter can operate as a
6-digit serial input meter (or remote display) to display serial data received from a computer or
PLC, or act as a slave display to another meter, counter or timer with a serial output. A signal
conditioner board is not required, but will not interfere with remote display operation if installed.

The serial I/O interface can be provided by any of the following:

RS232 board: single RJ11 or RJ11 & USB connectors for point-to-point communications.
ASCII Protocol Serial Communications Manual available on our website.

RS485 board: two RJ11 or RJ11 & USB connectors for multipoint communications, with
digital addressing of up to 31 devices. Jumper selectable 2-wire (half duplex) or 4-wire (full
duplex). ASCII Protocol Serial Communications Manual available on our website.

Modbus RS485 board: two RJ45 connectors for multipoint communications, with digital
addressing of up to 247 devices. Jumper selectable half duplex (2-wire) or full duplex
connection. Modbus Protocol Serial Communications Manual available on our website.

Slave display operation to the RS232 output of another meter requires that the jumper h be
installed on the RS232 board of the slave meter. Also required is a reversing phone cable ,
where the wire colors of the two connectors are reversed from left to right. For more infor-
mation, please see the Serial Communications Options section of this manual or the Jumper
Settings sections of the Custom ASCII Protocol Serial Communications Manual.

With an optional relay output board  (contact or solid state relays), the serial input meter can
provide remote alarm or control capability. The meter can be programmed so that the relays
respond to the displayed reading or to received control characters. For setup information,
please see the Dual Relay Output Option section of this manual.

With the optional analog output board, the serial input meter can provide an isolated,
scalable 4-20 mA, 0-20 mA or 0-10V analog output which tracks the displayed reading, thereby
serving as a serial-to-analog converter. For setup information, please see the Analog Output
Option section of this manual.

Front panel setup required for serial input meter (or remote display) operation is shown on
the next page. Two items require special explanation:

The first digit under ConFig item should to be set to a value 6 thru C. If no signal condi-
tioner board is detected, the meter defaults to setting 6, where H, L, K commands are
enabled. H means display the remote data only. K means that the received value is stored
as Item #3, to become the source for alarm comparisons and analog output. L means both
H and K. In slave mode, the remote meter can display any item of up to four data Items (or
string values), such as the Sum of Rates A & B (Item #1), Rate A (Item #2), or Rate B (Item
#3).

A timeout ti_Out can be set to a value from 10 ms to 199.99 sec. This is how long a serial
reading will be displayed in the absence of a new serial input. If timeout is set to 0, the
display will persist indefinitely in the absence of a new input.
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Additional programmable features  of the serial input meter are detailed in the “Command
Mode for Remote Display Operation of Counter / Timer” and “Data Formats” sections of the
Custom ASCII Protocol Serial Communications Manual. In particular, Mode 12 (hex C), which
is invoked by setting the first digit under ConFIG to C, allows extraction of data from an ASCII
string that contains multiple data values or non-numeric characters. This mode can accom-
modate selected Start and Stop characters. Any number of characters between the Start
character and the data can be masked OFF. Up to 8 display characters (including sign and
decimal point) can be masked ON. Any number of characters between the last displayed
character and the Stop character can be masked OFF.

Instrument Setup software is required to set up parameters for the Remote Display in Mode 12
(hex C). This software is downloadable from our website.

SELECTED FRONT PANEL SETUP ITEMS FOR SERIAL INPUT M ETER (not consecutive)
If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

¥ Press Y Press Digit JAN Press Value Select
> Menu | f29¥4 Select Key e Key

Display mode [B Remote display (H, K, L commands)

Configu- Single-value remote display

ration B Show 1% string value, slaved to another meter
[ Show 2" string value, slaved to another meter
A Show 3™ string value, slaved to another meter
B Show 4" string value, slaved to another meter
Custom Start, Stop, Skip, Show characters

RN | Select [§ thru [§ for flashing digit to set time-out in

Time-out seconds. Decimal point location is fixed for 10 ms

Select digit to flash. resolution.

B Baud rate

(2 ENY [i] [&X
o7 JGo

ONNFY ki 2 &

$% &' #
(" 0 ) !
| 000 § - o+, (-
+%,
BN / B & 0 12 &

Addr 000 oool oooMl 158 N 3 Fr ! &3 3#+




| 13. DUAL & QUAD RELAY OUTPUT OPTIONS I

An optional relay board may be installed in the meter main board at plug position P2, adjacent
to the power supply board. Four board versions are available: 2 or 4 relays, contact or solid
state. Once installed, the relay board is recognized by the meter software or PC-based Instru-
ment Setup software, which will bring up the appropriate menu items for the type of board.
These menu items will not be brought up if a relay board is not detected. Menu selections for
relays 3 and 4 will not be brought up if the dual relay board is detected. All relay boards offer a
choice of operating modes: normally off or on, latched or non-latched, hysteresis band,
deviation band, alarm based on filtered or unfiltered signal, and selectable number of readings
in alarm zone for alarm. The source compared to the setpoint may be the displayed item or a
non-displayed item. Please see the Glossary at the end of this manual for an explanation of
special terms.

VIEWING & CHANGING SETPOINTS

The < (Alarms) key can be used to step through and view setpoints while the meter continues
to make conversions and performs setpoint control. If the > (Peak) key is pressed while a
setpoint is displayed, conversion stops and the setpoint can be changed. After pressing < you
have 30 seconds, or the meter reverts to the normal display. To view setpoints, menu item
Locl, digit 4, must have been set to 0. To change setpoints, menu item Loc4, digit 6, must
have been set to 0.

il Press Py Press Digit Press Value Select
s Alarms P4 Select Key reseT BLGY
3950.00 3950.00 3050.00

Press < (Alarms)
to display Alarm 1

(7]
0]
—
o
Q
=]
—

Current setpoint 1 value blinks, and
Alarm 1 LED indicator lights. Press
> to select a digit, which will blink.

To change setpoint 1 value,
press A to change selected
blinking digits.

3950.00
Press < (Alarms)
to display Alarm 2

(7]
0]
—
o
Q
=]
—

3950.00

Current setpoint 2 value blinks, and
Alarm 2 LED indicator lights. Press
> to select a digit, which will blink.

3050.00

To change setpoint 2 value,
press A to change selected
blinking digits.

3950.00
Press < (Alarms)
to display Alarm 3

(7]
0]
—
o
Q
=]
—

3950.00

Current setpoint 3 value blinks, and
Alarm 3 LED indicator lights. Press
> to select a digit, which will blink.

3050.00

To change setpoint 3 value,
press A to change selected
blinking digits.

3950.00
Press < (Alarms)
to display Alarm 4
setpoint.

3950.00

Current setpoint 4 value blinks, and
Alarm 4 LED indicator lights. Press
> to select a digit, which will blink.

3050.00

To change setpoint 4 value,
press A to change selected
blinking digits.

glolelo? Press < (Alarms) again. Meter will reset and display the current reading.
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KEYSTROKES FOR SETUP
If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

WS Press
> Menu

Press Digit
PEAK, Select Key

Press Value Select
reseT MG

0000 Filtered item ltem #2
Source to com- | Setpoint 1 compared to: E ltem #1 Item #3
are to setpoint : :
P pol 0000 Filtered item ltem #2
Setpoint 2 compared to:  |H Item #1 ltem #3
0000 Filtered item ltem #2
Setpoint 3 compared to: [l Item #1 ltem #3
0000 Filtered item ltem #2
Setpoint 4 compared to:  |H Item #1 ltem #3
00000 B Relay 1 on Relay 2 on
Alarm Setup Relay state when alarm is Relay 1 off Relay 2 on
for relays 1 & 2 | active Relay 1 on Relay 2 off
if detected. Relay 1 off Relay 2 off
Press > until | Yo B AL1 auto reset AL2 auto reset
ALSEt s Alarm latching or non- AL1 latching AL2 auto reset
displayed. latching (auto reset) AL1 auto reset AL2 latching
(see Glossary) AL1 latching AL2 latching

B AL1 active high AL2 active high
Alarm operates at and AL1 active low AL2 active high
above setpoint (active AL1 disabled AL2 active high
high) or at and below AL1 active high AL2 active low
setpoint (active low). AL1 active low AL2 active low
(see Glossary) AL1 disabled AL2active low

B AL1 active high AL2 disabled

AL1 active low AL2 disabled

B AL1 disabled AL2 disabled
B AL1 band deviation AL2 band deviation
Hysteresis mode or band AL1 hysteresis AL2 band deviation
deviation mode AL1 band deviation AL2 hysteresis
(see Glossary) AL1 hysteresis AL2 hysteresis

No deviation or hysteresis on menu.

Number of consecutive
readings in alarm zone to
cause an alarm

After 1 reading

After 2 readings
After 4 readings
After 8 readings

OO0 [N = O]

After 16 readings
After 32 readings
After 64 readings
After 128 readings

[~ [o |O1 [N
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Press > Press Digit JAN Press Value Select

Menu P4 Select Key el Key

.

B Relay3on Relay 4 on
Alarm Setup Relay state when alarm is Relay 3 off Relay 4 on
for relays 3 & 4 | active. Relay 3 on Relay 4 off
if detected. Relay 3 off Relay 4 off
00000 @ Alarm 3 auto reset  Alarm 4 auto reset
Alarm latching or non- Alarm 3 latching Alarm 4 auto reset
latching (auto reset). Alarm 3 auto reset Alarm 4 latching
(see Glossary) Alarm 3 latching Alarm 4 latching

00000 @ AL3 active high AL4 active high
Alarm operates at and AL3 active low AL4 active high
above setpoint (active AL3 disabled AL4 active high
high) or at and below AL3 active high AL4 active low
setpoint (active low). AL3 active low AL4 active low
(see Glossary) AL3 disabled AL4 active low

B AL3 active high AL4 disabled

AL3 active low AL4 disabled

B AL3 disabled AL4 disabled
] AL3 band deviation AL4 band deviation
Hysteresis mode or band AL3 hysteresis AL4 band deviation
deviation mode AL3 band deviation AL4 hysteresis
(see Glossary) AL3 hysteresis AL4 hysteresis

Number of consecutive
readings in alarm zone to
cause an alarm.

After 1 reading

After 2 readings
After 4 readings
After 8 readings

After 16 readings
After 32 readings
After 64 readings
After 128 reading

(OO0 [N = O]
[~ [o O1 [N

Press Press Digit o] Press Value Select
> Menu prva Select Key reseT NG

RI=OIENE] Alarm 1 hysteresis 0.00000§0.00000§0.00000 ST - ORI RO R{IM i E S glTle

SIEVAE] Alarm 2 hysteresis 0.0000010.0000010. 00000 MikelChy g thru § for other
Select digit to flash ashing digits. Alarms will

IS Alarm 1 band deviation activate above the setpoint

— by the value entered and
B]={W]gpde] Alarm 2 band deviation deactivate below the setpoint
RISWIKIE] Alarm 3 hysteresis by the value entered. See
Glossary.

B]SOf%is] Alarm 4 hysteresis

BISW]kie] Alarm 3 band deviation

BISW]lle] Alarm 4 band deviation

* See Glossary for explanation of item.

- B50O-




14. SINGLE & DUAL ANALOG OUTPUT OPTIONS

Two versions of an analog board may be installed in the meter at rear panel jack position J4,
adjacent to the signal conditioner board. Once installed, this board is recognized by the meter,
which will bring up the appropriate menu items for it. These will not be brought up if an analog
output board is not installed.

A single analog output version can be configured for unipolar 4-20 mA current, 0-20 mA
current or 0-10V voltage, or bipolar -10 to +10V voltage (with a 20V voltage swing). Unipolar or
bipolar operation is selected by a jumper.

A dual analog output version  can be configured for two unipolar outputs, which can each be
4-20 mA, 0-20 mA or 0-10V. Current or voltage output is selected at each connector.

UNIPOLAR CONNECTIONS UNIPOLAR CONNECTIONS
4-20 mAor 0-20 mAOUTPUT 1| [m 4-20 mAor 0-20 mMAOUTPUT2 1 mm
0-10V OUTPUT 2| [ 0-10V OUTPUT2 2| [
ISOLATED GROUND 3| W ISOLATED GROUND 3| W
BIPOLAR CONNECTIONS 4-20 mAor 0-20 MAOUTPUT1 1| [m
REFERENCE or RETURN 1| mm 0-10V OUTPUT1 2| W
-10V to +10V OUTPUT 2| @MW ISOLATED GROUND 3| W
N/C 3 Im
Unipolar current or voltage: Jumper a No jumpers, only selections at the connectors.

Bipolar -10 to +10 voltage: Jumper b

With either board, current or voltage output is selected at the connector and in the Menu. The
low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low displayed
reading IEXI®]. The high analog output (20 mA, 0V or 10V) may be set to correspond to any
high displayed reading [IFX{gl. The meter will then apply a straight line fit between these two
end points to provide an analog output scaled to the meter reading. The decimal point location
is fixed by the selection.

KEYSTROKES FOR SETUP OF SINGLE ANALOG OUTPUT BOARD
If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

ke Press > Press Digit /\ Press Value Select
> Menu v Select Key foad Key

[ 00 ] 0-20 mA current output

Analog Output Setup. Calibration output 0-10V voltage output

Press > until AnSEt is selection. 2 4-20 mA current output

displayed. € -10V to+10V voltage output
[ 00 B Filtered item ltem 2
Analog output source. ltem 1 ltem 3

0.00000J0.00000§0.0000 O RS ORI ORI Ri ESgITale R [To]18

Low displayed value for 0.00000J0.00000§0.00000

-10V, OV, 0 mA, or 4 mA | gglect digit to flash

0.00000J0.00000§0.0000 O RS ORI ORI Ri ESgITale R [To]18

RlTe[g NI o] E\/To RVEI VISR (SN N0 00000J0.00000§0.00000

10V or 20 mA output Select digit to flash
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KEYSTROKES FOR SETUP OF DUAL ANALOG OUTPUT BOARD
If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Press Digit Press Value Select
> Menu v Select Key foad Key
0000 ] 0-20 mA current output
Analog Output Setup. Scaling of analog output 2 0-10V voltage output
Press > until AnSEt is 4-20 mA current output
displayed. 0000 @ Filtered item ltem 2
Source of analog output 2 ltem 1 ltem 3
0000 @ 0-20 mA current output
Scaling of analog output 1 0-10V voltage output
4-20 mA current output
0000 @ Filtered item ltem 2
Source of analog output 1 ltem 1 ltem 3
0.00000J0.00000§0.0000 O RS EE OR I ORI R ESaITae Ko [To]18

Low displayed value for
0V, 0 mA, or 4 mA output

0. :
0.00000J0.00000§0.00000

Select digit to flash

0.00000§0.00000§0.00000 IS ORI OR{ IR ESaiTalo Ko Te i
High displayed value for 0.00000J0.00000§0.00000 selection.

10V or 20 mA output Select digit to flash

0.00000J0.00000§0.0000 O RS ORI ORI Ri ESaITale R [To]18
Low displayed value for 0.00000J0.00000§0.00000

OV, 0 mA, or 4 mA output | geject digit to flash

0.00000J0.00000§0.0000 RS ORI ORI R ESaITale R [1o]18
RlTe[gNIo]E\/To RVEI VISR (S N0 00000J0.00000§0.00000

10V or 20 mA output

Select digit to flash
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| 15. SERIAL COMMUNICATIONS OPTIONS I

A serial communications board  may be connected to the meter main board at plug position
P13 (middle position). Available boards are RS232, RS485 (with dual RJ11 connectors),
RS485 Modbus (with dual RJ45 connectors), USB, USB-t0-RS485 converter, Ethernet, and
Ethernet-to-RS485 converter. The dual connectors of RS485 boards are wired in parallel to
allow daisy chaining of addressable meters without use of a hub. Three serial communication
protocols are selectable for all serial boards: Custom ASCII, Modbus RTU, and Modbus ASCII.

A USB-t0-RS485 converter board or an Ethernet-to-RS485 converter board  allows a meter
to be interfaced to a computer and be the device server for a network of up to 31 other meters
on an RS485 bus, while itself retaining all capabilities of a meter. The remote meters need to
be equipped with our RS485 digital interface board with dual 6-pin RJ11 jacks, not our RS485
digital interface with dual 8-pin RJ45 jacks. The dual 6-pin RJ11 jacks on the RS485 board are
wired in parallel to allow multiple meters to be daisy-chained using readily-available 6-wire
data cables with no need for hand-wiring or an RS485 hub. The outer two wires are used for
ground.

Use 6-wire, straight-through data cables, not 4-wire telephone cables or crossover cables,
all the way from the device server to the last device on the RS485 bus. Connect ATX to ATX,
BTX to BTX, etc., with no crossover as you go from device to device.

To connect a meter with a USB board to a computer, use a USB cable with Type A and
Type B connectors. The computer will display “Found new Hardware” followed by “Welcome to
the Found new Hardware Wizard.” Follow the instructions for software installation from a CD.
When the installation is complete, use Device Manager to determine the com port. To get to
Device Manger, go to the Windows Control Panel, click on System, click on the Hardware tab,
then click on Device Manager. Go down the device list and click on Ports (COM & LPT) and
USB serial port (com #). Note the com port # for use with communications to your meter, then
exit Control Panel. If you later need to change the Com port, right-click on USB serial port
(com #), then on Properties, Port settings, and Advanced. Change port to the desired number,
click OK, then exit Control Panel.

To connect a meter with an Ethernet board to a comp  uter, see our separate Ethernet
Manual, which covers our Node Manager Software. This Windows-based application runs on a
host computer and is used to configure our Ethernet Nodes. It automatically discovers all
Nodes on a LAN or WAN, plus any devices connected to Server Nodes via an RS485 bus. It is
used to configure each Node, such as setting communication parameters, naming the Node
and associated devices, entering email addresses for alarm notification and data requests,
selecting the Node's time zone for time-stamping of emails and streaming data, and upgrading
firmware. Once configuration data has been stored in flash memory of all Nodes, Node
Manager Software can be closed.

BOARD SETUP VIA JUMPERS

USB Board

No jumpers required.
USB
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Basic Ethernet Board
No jumpers needed.

Ethernet
RS232 Board
e - Normal operation.
f - Slave display to RS232 from another meter.
g - Pull-up resistor on RTS line.
Note: Board is shipped with jumpers e and g installed RS-232 wmenfmgm

RS485 Board, Full Duplex Operation
b & d - Installed on last meter in long cable run.
RS485 Board, Half Duplex

a & ¢ - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

mdm nbucCunds

RS-485

RS485-Modbus Board, Full Duplex Operation

b & e - Bias jumpers should be installed on 1 board.
a & d - Installed on last meter in long cable run.

RS485-Modbus Board, Half Duplex Operation

b & e - bias jumpers installed on 1 board.
c & f - installed for half duplex operation.
a - installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

Modbus

Ethernet-to-RS485 Converter Board
& USB-t0-RS485 Converter Board

Full Duplex Operation

No jumpers for short cable runs.
Add b & d for long cable runs.

Half Duplex Operation

a + c for short cable runs.
Add d for long cable runs.

Ethernet-to-RE485

wdm abmow ngle

USB/RS485
man sbuCunds
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KEYSTROKES FOR SETUP
If the MENU > key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

WS Press
> Menu

Press Digit
PEAK, Select Key

Press Value Select
FE

=4 Key

| 000 B Send unfiltered signal

Serial Setup 1. Output filtering Send filtered signal

Sort ils-d'isu;;:gg/ed __000 § 300 baud 4800 baud

" | Baud rate 600 baud 9600 baud

Fixed Parameters 5288 l;aug B 19200 baud

No parity = au

8 data bits 000 Bl Output at reading rate rr.

1 stop bit Digital output rate. Output at rr/2 Output at rr/32
rr = reading rate. Outputatrr/4 [ Output at rr/64
rr depends on gate time and Output at rr/8 Output at rr/128
input frequency. Output atrr/16 B Output at rr/256

0000 No LF after carriage return

Serial Setup 2 Line feed LF after carriage return

0000 No alarm data

>

larm data with readings

Alarm data with reading

o
o
o
(@)

Output mode control

[~ [O M- [OJ- (O]

Continuous data output
Data output on ASCII command only

(0]0]0)
Meter address with Custom
ASCII protocol*

!

Select @ thru [§ for addresses 1 thru 15.
Select [0 thru [@ (with decimal point) for
addresses 16 thru 31.

Serial Setup 3

AN Half or full duplex |® Full duplex Half duplex
00000 @ * (asterisk) is recognition character.

Recognition characters,
start & stop characters.

Special characters have to
be downloaded via
Instrument Setup software.

10O IEIN Bl |

No start & stop characters.

Custom recognition character.

No start & stop characters.

* (asterisk) is recognition character.
Special start & stop characters.
Custom recognition characters.
Special start & stop characters.

oloJole]ld RTS mode

—+

Normal RTS M Single

ransmission

CR (LF) termination cha-
racters.

[~ O]

Only at end of all items
At end of each item
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Press Press Digit Press Value Select
> Menu P4 Select Key reseT MG

>

B All Active ltems
Data sent in continuous Item #1 only
mode ltem #2 only (if active)
ltem #3 only (if active)
Peak only
Displayed Item
@ Vvalley only
All Active Items + Peak + Valley
000 @ 1sec
Serial Setup 4 Modbus* ASCII gap timeout 3 sec
5 sec
10 sec
000 B Custom ASCII*
Serial protocol Modbus* RTU
Modbus* ASCII
000 @ None
Parity Odd
Even
|__0ooj 000 000
Modbus Address Select digit to flash. Select [§) thru ] for flashing digit.

Address range is 1 to 247.

* See Glossary for explanation of item.
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| 16. EXCITATION OUTPUTS & POWER SUPPLIES I

Three isolated transducer excitation output levels are available from the power supply
board. These are selectable via jumpers b, c, d, e, f in the upper right of the board, as
illustrated. In addition, the board provides three jumper positions for special features. The
same jumper locations apply to the universal power supply (95-240 Vac £10% or 95-300
Vdc) and to the low voltage power supply (10-34 Vac or 10-48 Vdc, Micro-C & Mighty-1C
only).

- i ' 000 goo
e bed e f
I il
A ‘h g o | -
og OO0 -
Excitation output Jumper locations
b d -]
5 Vdc +5%, 100 mA max b,d, e [ BN BN BN BN B B
0 b d f
10 Vdc £5%, 120 mA max b, d,f EEEE EEE
24 Vdc 5%, 50 mA max c c
H R E R H B N

SELECTION OF OTHER JUMPERS

Jumper a - Front panel menu lockout, locked when installed. (See Section 9)
Jumper g - Provides +5V power output at P1-4 when installed.
Jumper h - Connects "Digital Input B" to P1-4 when installed.

Note: The excitation power supply is floating with respect to meter ground. When powering
transducers that have a common signal low and power supply return lead, jumper minus
excitation to signal ground. Selection of Excitation Output 5V, 10V or 24V and the Menu
Lockout are accomplished by jumpers on the P1 power supply. Unless specified at time of
order, meters are shipped with 10Vdc Excitation Output selected.
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MIGHTY-5C POWER SUPPLY

The Mighty-5C uses a switching power supply that operates from 95 to 240Vac. See the
diagram below when connecting power. This power supply is in addition to and works in
conjunction with the P1 power supply shown in Section 21.1. Signal Input and Excitation
Outputs are connected to the Mighty-5C at P5. See Section 4 for connections.

ACHIGH
EARTH GROUND
AC NEUTRAL

Might-5C Power Supply
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| 17. DIGITAL CONTROL INPUTS I

FUNCTION OF DIGITAL INPUTS

Meter Reset Logical O: The microcomputer reads and resets the meter to the values
stored in nonvolatile memory. If totals are saved on power
down, totals are reset to the saved value, otherwise totals are
set to zero or to the offset value if offset is not zero.

Function Reset Logical 0: All totals are reset to zero or to the offset value if offset is not
zero, alarms are reset and peak display resets to minus
overload.

Peak Display Logical 0: The peak value of the filterable item is displayed.
Logical 1: The present value the selected item is displayed.

Hold Logical 0: The meter display and outputs are held at the last reading prior
to the hold going low. Meter continues to totalize while meter is
in hold.

Logical 1: The display and outputs are updated normally.

External Gate Logical 0: The gate time starts when input goes low and ends when gate
time goes high.

Logical 1: When external gate is selected, it overrides the internal gate. At
power-on, the meter displays reset until the external gate input
goes low and then high to complete a conversion. The new
value will then be displayed until a new external gate occurs.

Display Blank Logical O0: The display and indicator lights are blanked.
Logical 1: The display and indicator lights are lit.

Display Item 2 Inputs A & B Logical 0 or 1: Item displayed.
& Item 3 Input A Logical 0 & Input B Logical 1: Item 2 displayed.
Input B Logical 0 & Input A Logical 1: Item 3 displayed.
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18. INSTRUMENT SETUP VIA PC

Instrument Setup software is a PC program which is much easier to learn than front panel
programming. It is of benefit whether or not the meter is connected to a PC. With the meter
connected to a PC, it allows uploading, editing and downloading of setup data, execution of
commands under computer control, listing, plotting and graphing of data, and computer
prompted calibration. With the meter unconnected to a PC, it provides quick selection of
jumper locations and a printable display of menu selections for front panel setup.

SOFTWARE INSTALLATION

Download IS2*.exe onto your PC from the web or the distribution CD. Double-click on the
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory,
double-click on setup.exe, which will install the software on your PC.

PREREQUISITES FOR CONNECTED USE

1) PC with available RS232 com port.

2) Meter to be set up. 5uﬁuuo
3) RS232 board in meter. This board can be used | 5 2 00Q0
for setup, then be removed. __ =

4) RJ11-to-DB9 RS232 cable to connect meter and RJ11-to-DBY RS-237 cable
PC (see Section 1, Ordering Guide).

5) Instrument Setup software.

ESTABLISHING COMMUNICATIONS

Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs =>
IS2 => [S2. Click on RS232 => Establish. The program will temporarily set the selected Com
port to the required baud rate, parity, data bits and stop bit. Once communications have
been established, click on Main Menu. The software will sense the type of meter and
installed boards, but it cannot sense jumpers positions nor set jumpers for you. If the
computer is not connected to a meter, select Counter/Timer and Series 2.

ComPorts——— Baud Rate

~Protocol Select Instrument and Series
® Com1 o 200 ® Custom ASCTE | _panel Meter Transmitter
O Com2 O 600 © Modbus RTU Main Menu
O Com3 © 1200 O Modbus ASCTI ODEM O Analag Input
O Coma 4 © 2400 Help | :
O Com 5 © 4800 — © Weight Meter

Parity
O Comé @ 96500 on @ Counter/Timer O Counter/Timer
O Com 7 019200 o Back
O Com$
O Com9 Quit | Series

ui
O Series 1

Other Com Port
l— @© Series 2

[Wait while pting to

Back Quit
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SETUP OF CONNECTED METER

A setup file can be retrieved from the meter (Counter => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (Counter => Put Setup). Downloading of
setup files from a PC can be a major time saving when multiple counters have to be set up
in the same way.

You will find that Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.

ADDITIONAL FEATURES WHEN CONNECTED

The Commands pull-down menu allows you to perform Reset functions, to enter nume-
rical values into the meter, and to retrieve numerical values from the meter (Items 1, 2, 3,
Peak, Valley).

2900.

2875,

2850,

2825,

2800.

1280

1024

768

512 o

256

o

T T T T
1] 1. 2. 3 4 5 6. 7

] ] , 3 10 2725. 2750. 2775. 2600. 2625. 2850. 2675.
Print Save Pause | Continue | New Scale End Print Save | Pause | Continue | New Scale End
Plot Graph

- The Readings pull-down menu

provides three formats to display meter data on the PC

monitor. Use the Pause and Continue buttons to control the timing of data collection, then
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press Print for a hardcopy record on your PC printer.

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. This is one method to capture peak readings.

- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC
combination into a printing digital oscilloscope.

- Graph generates a histogram, where the horizontal axis is the reading and the vertical
axis is the number of occurrences of readings. The display continually resizes itself as
the number of readings increases.

The Jumpers pull-down menu  shows board jumper corresponding to specific user selec-
tions.

The Calibration pull-down menu  allows easy frequency calibration of the quartz crystal.
Simply apply a known calibration frequency up to 1 MHz to Channel A of the dual channel
signal conditioner board, type in the frequency value in Hz, and press Enter.

METER SETUP WITH AN UNCONNECTED PC

Instrument Setup software is also of benefit when the
PC is not connected to a meter.

Upon launching the software, click on None for
Communications, then on Counter/Timer and Series
2. Click on File => Default Setup to retrieve a default
setup file from disk, or on File => Open Setup to
retrieve a previously saved setup file from disk.

To enter new setup information, click on View =>
Setup, then make your screen selections as if you
were connected to a meter. Tabs will be grayed out if
you have not selected the required hardware under
the Input+Display tab. When done, press on Main
Menu, then on View => Menu. The selections made
under Setup will now be shown in the form of the
required front panel programming sequence, where
each row corresponds to a menu item selected by
the > key, and the seven data columns correspond
to values entered via the > and A keys.

Click on any step in the sequence to bring up a
detailed help window.

Click on Print for a hardcopy, which you can then
use as an instruction sheet to program your meter
via its front panel.

Click on Main Menu => File => Save Setup As to
save your setup to disk and have an electronic
record.
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| 19. CUSTOM CURVE LINEARIZATION I

Curve.exe is a DOS-based, executable PC program used to set up an Extended meter* so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for non-linearity of nominally linear transducers, or to display volume
from liquid level or from pressure at the

bottom of an irregularly shaped tank. The

curve fitting algorithm is uses quadratic

segments of varying length and curvature,

and provides diagnostics to estimate curve

fitting errors. The program is self-prompting,

avoiding the need for a detailed printed

manual. This manual section is only intended

as an introduction and get-started guide.

PREREQUISITES
1) PC-compatible computer with an available RS232 or USB port.
2) Extended meter*.
3) A serial communication board in the meter. This
board can be removed following meter setup.
4) A suitable cable to connect the meter to a PC.
5) Curve.exe software (downloadable at no charge).

GETTING STARTED

Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter to custom curve linearization. To do so, press the > key to get to
[@iIFe]. then set the fifth digit to ll. This digit will only be displayed with an Extended meter*.
Set the meter baud rate to 9600. To do so, press the > key to get to =g, then set the
entry to Il{§E8. Set the meter address to 1. To do so, press the > key to get to J=g#, then
set the entry to [SFEl. To execute the program from Windows, simply double-click on
curve.exe. No software installation is required.

OPERATING MODES

The program will prompt you to enter your data in one of four modes. Pressing R (Enter) at
any time returns you to the main menu.

1) Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV,
V, mA or A. Y is the desired corresponding reading and can range from -99999 to
99999 with any decimal point.

2) 2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.

3) 2-coordinate file entry mode, where an actual X input signal is applied, and the
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desired Y reading is provided from a file.

4) Equation entry mode, where the coefficients of a polynomial Y = K1X"P1 + K2X"P2 +
K3*X"P3 + ... are entered. Up to 20 terms are allowed. And offset can be built into X.

REQUIRED USER INPUTS
Select CTR

You will be asked to supply the following:

LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >

This informs the computer of your signal conditioner jumper settings. Enter O and O for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mA or 10 for 10V. For HIGH INPUT MEASUREMENT VALUE, enter 100000,

You will be asked to select the position of the decimal point from 6=X.XXXXX, 5=
XX XXX, 4=XXX XXX, 3=XXXX. XX, 2=XXXXX. X, 1=XXXXXX (for DPMs, the leading X
is a blank). Specify the same position that you specified in the decimal point
menu selection.

| 20. METER CALIBRATION I

All ranges of the meter have been digitally calibrated at the factory prior to shipment using
computers and calibration equipment certified to NIST standards. If recalibration is required,
the meter may be returned to the factory or to any authorized distributor.

For frequency and rate measurements with the dual-channel signal conditioner, a calibration
correction to the quartz crystal oscillator is stored in EEPROM on the main board. Calibration
constants are also stored in EEPROM in the process receiver & totalizer signal conditioner
board and in the analog output board. As a result, these two boards can be mixed and inter-
changed without requiring recalibration.

For frequency calibration using the dual-channel signal conditioner board, calibration may be
performed in the field as follows using the front panel pushbuttons:

Set InPut to rAtE and A only.

Enter 0 in CALIb to set initial correction to 0 PPM.
Set SCALE to -9.99999

Set OFFSt1 to 999999

Apply a 100 kHz reference signal to channel A.
Enter the displayed reading in CALIb.

ogahrwWNE

For calibration of the process receiver & totalizer signal conditioner board or analog output
board, an RS-232 board must be installed in the meter for serial communication with a PC.
This board may be removed upon completion of calibration. Calibration software and step-by-
step instructions are available from the factory.
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| 21. MECHANICAL ASSEMBLY & PANEL MOUNTING, MICRO-C I

REMOVING THE REAR PANEL

To remove the rear panel, first remove any connectors that are installed. Press down on
both rear panel retaining tab releases and pull the top of the rear panel away from the case.
The bottom of the rear panel will now lift out.

REMOVING THE METER FROM THE CASE

After removing the rear panel, the meter can be taken out of the case by carefully grasping
the power supply board and signal conditioner board at the connectors and sliding the unit
out the back of the case.

REASSEMBLING THE METER

Reverse the preceding procedures to reinstall the meter in the case. After the meter is in the
case, insert the bottom tabs on the rear panel into the case first. Care must be taken to
ensure the printed circuit boards are properly aligned by the board retaining pins on the
inside of the rear panel.
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PANEL MOUNTING THE MICRO-C

Ensure the O-ring is in place. Turn the two mounting screws counterclockwise until the
space between the mounting pawl and the bezel is greater than the panel thickness. Insert
the meter in the panel cutout. Turn the mounting screws clockwise until the meter is
securely mounted in the panel. Do not over tighten the mounting screws.

CONNECTORS, ALL MODELS

All models of the Micro Series uses UL/VDE rated screw
terminals.
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| 22. MECHANICAL ASSEMBLY & PANEL MOUNTING, MIGHTY-1 C I

REMOVING THE REAR PANEL

To remove the rear panel, first remove any connectors that are installed. Remove the 6
screws holding the back plate in place and pull the rear panel away from the case.

REMOVING THE METER FROM THE CASE
After removing the rear panel, the meter can be taken out of the case by carefully grasping

the power supply board and signal conditioner board at the connectors and sliding the unit
out the back of the case.

REASSEMBLING THE METER
Reverse the preceding procedures to reinstall the meter in the case. After the meter is in the

case, align the board with the back plate holes and install and tighten the six back plate
screws.
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PANEL MOUNTING, MIGHTY-1C

The Mighty-1C is mounted to the panel by two sliding metal plates located on each side of
the case. To mount the Mighty-1C into a panel, remove the two screws from the rear of the
panel that hold the sliding plates. Remove the two plates. Slide the Mighty-1C into the panel
cutout, replace the two sliding plates and their holding screws. Tighten the holding screws
until the plates are firmly held against the rear of the panel.
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| 23. MECHANICAL ASSEMBLY & MOUNTING, MIGHTY-5C I

OPENING THE CASE

To remove the display board assembly from the case, loosen the outer nut on the cable
clamp located on the left side of the case so that power and signal cables are free to move.
Remove the (16) rear panel screws and remove the rear panel. Remove the (16) 10-32 nuts
using a 3/8" nut driver. Lift the entire display board assembly with all option boards from the
enclosure while sliding all wiring through the cable clamp.

ACCESSING THE 1/0 CONNECTORS

After removing the display board assembly, all plug-in boards and their I/O connectors are
accessible. Boards may be added or deleted by first removing the plug-in I/O connectors
and then the (4) screws securing the module hold-down board.

REASSEMBLING THE DISPLAY

Reverse the preceding procedures to reassemble the case. First install the display board
assembly and the (16) 10-32 hex nuts (do not over tighten). Next install the back panel with
the gasket in plane with the (16) 6-32 screws. Feed wiring through the cable clamp, and
tighten the outer nut.
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MOUNTING THE MIGHTY-5C

Depending on which mounting option was purchased, Mighty-5 displays may be mounted
using the bale or the rear panel mounting holes.
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| 24. SPECIFICATIONS, MICRO-C, MIGHTY-1C, MIGHTY-5C I

DISPLAY
Type, Micro-C......... 6 LED digits, 7-segment, 14.2 mm (0.56”) high digits & 4 LED indicators
Type, Micro-1C......... 6 LED digits, 7-segment, 25.4 mm (1.0”) high digits & 4 LED indicators
Type, Micro-5C.......... 6 LED digits, 7-segment, 127 mm (5.0”) high digits & 4 LED indicators
Digit Color......ccccviieiiiiieeeeiee e, Red or green for Micro-C, red for Mighty-1C & Mighty-5C
DISPlay RANGE ... ..o -999999 to +999999

CONVERSION (FREQUENCY INPUT)

CONVEISION TECNNIGUE ...ttt e e e e e e e e e ee et e e e e e e e aeeeenennns 1/period
Conversion RAte..........ccovvveiiiiiiiiiiiiieee e Gate Time + 30 ms + 2 signal periods (max)
GaLE TIME.. et a e 0 to 199.99 sec (selectable)
Time Before Zero Output (TIMe-Out) ......ccoeeeeiiiiiiiiiiiiieeeeeeeeeeiiees 0 to 199.99 sec (selectable)
Output & Display Update Rate ...........cooevvvviiiiiiiieieieiiiiieee e Same as conversion rate
TiME BASE ACCUIACY ...cceeviiiiiiiieeeeeeeeeiiiie e e ettt e e e e e eeeaen e e e e e e e Calibrated to £2 ppm

INPUT ISOLATION

CMV from DC t0 60 HZ......cooiiiieiiiee e Withstand 250Vac
Dielectric strength...........ccooooiiiiiiiiii 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

DUAL CHANNEL SIGNAL CONDITIONER

ACCUTACY AL 250C ... et e ettt e e ettt e e ettt e e e e eaa e e e e eaan e e eeennnnns +2 ppm
=T 101 Lol o TP +1 ppm/degree C
Long-Term Drift Of Crystal .........ooouiiiiii e 15 ppml/year
Signal Types............... AC, NPN, PNP transistor outputs, contact closures, magnetic pickups
Max Pulse Rate ..........oouviiiiiiiiiiiiie e 1 MHz on Channel A, 250 kHz on Channel B
Channel Isolation.............cooovveiiiiiiiiiiieeeeeeees Channel A & channel B share common ground
LOW PasS Filter......oooooiiiiie e 250 Hz or 30kHz (selectable)
HY SEEIESIS. .. eeaaeees 15 mV to 2.2 Vp-p (selectable)
TrQGEr [EVEL. ... +15 mV to £1.7 V (selectable)
DEDOUNCE CIFCUILIY .. 0, 3, 50 ms (selectable)

PROCESS RECEIVER & TOTALIZER SIGNAL CONDITIONER

Signal LeVEIS ... 0-1 mA, 4-20 mA, 0-10 V (selectable)
ACCUTACY AL 250C .. .. it e et e ettt e e e et et e e e e e et e e e e eaa e e e aennnnns +0.025%
SPAN TEIMPCO ...ttt et e et e e et e e e eaa e e e eenanns +0.003% of reading /T
ZEIO TOIMPCO ..ttt et e e e e e et e e e e e e e e e e e eeaaaaeeeenes +0.003% of full scale /T

QUADRATURE SIGNAL CONDITIONER

SIGNAI TYPE e Differential or single-ended quadrature
TranSitioNS MONITOTEA.........uuuiiee e e e e x1, x2 or x4
Max Pulse Rate..........oouuviiiiiiiiiiiiiiee e 250 kHz at x1, 125 kHz at x2, 62.5 kHz at x4
Maximum Differential Signal AMPHTUAE...........ouveiiiii e 14V
Conversion TeChNIQUE fOr RAE........ooii it eeeeeeeeees 1/period
Conversion Time for Rate ..........ccoeeevvviiiiiiiiiiieeeeennnn, Gate time + 30 ms + 0-2 signal periods
Time Before Zero Output for Rate..........ccooveveiiiiiiiiiiiiiiee e, 0 to 199.99 sec (selectable)



Zero Wait Time for Rate ........cuvvuiiiiiieieiiie e 0 to 199.99 sec (selectable)
Output & Display Update Rate ...........cceevvviiiiiiieiieeeiiiiiee e Same as conversion rate
Time Base Accuracy for Rate..........couuuuiiiiiiiiiiiiiiii e Calibrated to £2 ppm

POWER REQUIREMENTS

Input Voltage rating (standard).............cceeveiieiiiiiiinnnnns 95-240V ac £10% or 90-300V dc +10%
Input Voltage rating (low voltage option) ...........coevviiiinniiiiiiieiiiii. 10-34V ac or 10-48V dc
POWET LiNE FIrEQUENCY .....uiiiieiieiieiiiiiie ettt e e e e e eeetaie e e e e e e e eeeeannne DC and 47-63 Hz
Power CoNSUMPLION, MAX ....cooiiiiiiiiiiiie ettt e e e e e e e eesaaa e e e e e e eeeeesennes 5 Watts

EXCITATION OUTPUTS

Voltage & Current Levels (jumper selectable) ...........ccccooeeeiiiiiininnnn. 5V dc £5%, 100 mA max
10V dc +5%, 120 mA max
24V dc £ 5%, 40 mA max

EXcitation OUIPUL RIPPIE .. .. 100 mV-p max
Isolation from PoOwer and OULPULS ........uuuiiiie et e e 250 Vac
Insulation dielectric strength to power and outputs..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
ISolation tO SIGNAl COMIMON ... e e e e e e e e e 50V dc

DUAL OR QUAD RELAY OPTIONS

Power to Relay OPtioN .......cooooiiiiiiiiiiiiie et Powered by meter
Setpoint SETUP.....euvveiiee e Via front panel pushbuttons or RS232/485
UPate RALE ... 56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (IMiN) .........eoiiiii e Display update rate
Input Signal (selectable) ... Filtered or unfiltered input signal
Actuation Modes (selectable)...... Above or below setpoint, latching or non-latching, disabled
Output Time Delay (Selectable) ... 1 to 128 readings
Front Panel Enable / Lockout Modes (selectable)................ 1) Display and change setpoints

2) Display but do not change setpoints
3) Neither display nor change setpoints

Alarm Status INAICAION ........coooiiiiiiiiii e 2 or 4 red LED lamps
Status Indication Setup (selectable) ...........ccooeviviiiiiiiiiiiinnnnnnee. Lit when output is ON or OFF
Contact Relay Output:

Y O - 11| o USSP 8A @ 240V ac
[T O = 1 T PSPPSR 8A @ 24V dc
Isolation rating between signal common and CONtaCtS .............eeiieeiiiiiiiiiiiiiiiiiee e, 250V ac
Insulation dielectric strength between signal common and contacts ............cccoeeeeeeeiiieiiiiiinnnn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Solid State Relay Output:

AC RAtiNG.....oeeiiiiiieeeeie e 120 mA @ 125V ac, 24 ohms series resistance
DTG = 1 Vo P 240 mA @ 150V dc, 6 ohms series resistance
Isolation rating between signal common and CONtaCtS .............eeiienieiiiiiieiiiiiiiiee e, 250V ac
Insulation dielectric strength between

signal common and contactS...........ccccceeeeeeeeiiieeeeeennnnn. 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
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ANALOG OUTPUT OPTION

Power to Analog OULPUL OPLION........uuuiiiieee et eeeaeeees Powered by meter
Output Levels, Single Analog Output Option............... 0-20 mA, 4-20 mA, 0-10V, -10 to +10V
Output Levels, Dual Analog Output Option ..........cccevveiiirieeeiiieiiinnns 0-20 mA, 4-20 mA, 0-10V
Voltage Compliance, 0-20 MA OUPUL .......cooeeiiiiiiiiiiiiieee e 12V (0-600 Ohm load)
Current Compliance, 0-10V OUtpUL.........cooeviiiiiinieeeeeeeeeiiiien 2 mA (5 kOhm or higher load)
ACCUIACY ..cevviiiiieeeee e Meter input accuracy £0.02% of full scale analog output
RESOIULION .t e e 16 bit (1 part in 65,536)
RESPONSE TIME ... e e et e e e e e eeeaennas meter update rate
Scaling of Reading for Zero OULPUL............ceoriiiiiiiiiiiiie e -999,999 to +999,999
Scaling of Reading for Full Scale OutpuUt.............coooviiiiiiiiiiiie e -999,999 to +999,999
Isolation rating between signal common and analog OULPUL.........cccoeeivviiiiiiiiiieeneeeeee. 250V ac
Insulation dielectric strength between signal common and analog output.............cccceevvvvvnnnnnnn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Serial Interface Option (USB, RS232, RS485, RS485-Modbus boards)
OULPUL TYPBS et RS232, RS485, RS485-Modbus, USB
.......................................... USB-t0o-RS485 converter, Ethernet, Ethernet-to-RS485 converter
Power to INterface OPtiON........ooiviiiiiiiiee e Powered by meter
RSA8BE WIING ..ttt e e e e e e e ettt e e e e e e e eeeeennnnes Half or full duplex
Baud RAteS......ccooe i 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols..........ccccceeeeeeennnnnn. Custom ASCII, Modbus RTU, Modbus ASCII (selectable)
Signal Levels.........oooiiiiiiiiiiiii e, Meet RS232, RS485, USB, Ethernet standards
Isolation rating between signal common and serial /O ...........cceiiiiiiiiiiiiiiiiiii e 250V ac
Insulation dielectric strength between signal common and serial /O ..........ccccoveiiiiiiiiiiiiiieennn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Option Board Connectors:
R S 23 s Single RJ11 jack
RS485 ... Two RJ11 jacks (for daisy chaining with 6-wire data cables)
RS485 Modbus.............euennn... Two RJ45 jacks (for daisy chaining with 8-wire data cables)
(610 TP USB type B plug
USB-t0-RS485 converter..........cccceeeeeeennnn. USB type B plug plus RJ11 jack to RS485 bus
EINEINEL.....e e Single RJ45 to Ethernet
Ethernet-to-RS485 converter.............. RJ45 jack to Ethernet plus RJ11 jack to RS485 bus
ENVIRONMENTAL
Operating TEeMPEIATUIE ........ouueiiieee ettt e e e e e e eeetaan e e e e eeaeeeennnnns 0C to 55T
StOrage TEMPEIALUIE ........ueeiii et e e e e e e e e e e enn e -40C to 85T
Relative HUMIdIty ..........uoiiiniiiiiiii e 95% from 0T to 40<C, non-condens ing
GBS e NEMA-4X from front when panel mounted
SNOCK e 10 G at 1 kHz, applied in X, Y, Z axes
Vibration ........ooeviiiiiii 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max
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| 25. GLOSSARY OF TERMS I

Adaptive filter threshold

A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average filter-
ing allows a meter to respond rapidly to actual changes in signal while filtering
out normal noise. The accumulated difference is also reset to zero when the
latest reading has a different polarity than the filtered reading. A low adaptive
filter threshold is normally selected. A high filter threshold should be selected if
the signal has large transients.

Alarm, latched
An alarm which stays actuated until reset.
Latched alarms can shut down machinery or a
process when an operating limit has been
exceeded, or maintain an alarm condition until
acknowledged by an operator.

Alarm, non-latched
An alarm which changes state automatically
when the reading rises above a specified limit
and changes back automatically when the
reading falls below a limit.

Autofilter A selectable digital filter mode which
automatically selects an appropriate moving
average filter time constant for the encountered
noise condition.

Batch control An operating mode of the Extended counter
with relay board, where the counter is used to
control repetitive fill operations by counting up
from zero to a preset, or counting down from a
preset to zero.

Calculated total
While most totals are based on direct pulse counts, certain totals are calculated
as running totals based on displayed rate (e.g., Total A, Rate A). The totalizing
process assumes that rate is displayed in units per second, such as 300
gallons per second, allowing a scale factor of 1 to be used. If the rate is not in
units per second, a different scale factor has to be applied.

Coordinates of 2 points method

A scaling method where the coordinates of 2 points are entered. For a pulse
rate input, the first entered point is would be low frequency in Hz and low
desired reading. The second entered point would be high frequency in Hz and
high desired reading.
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Counts

The reading displayed on the meter ignoring the decimal point.

Custom ASCII protocol

Custom curve

Cutoff

Deviation band

Duty cycle

A simplified, short protocol for use with panel meters, counters and timers. It
allows 31 digital addresses. Not an industry-standard protocol, like the more
complex Modbus protocol, which is also offered with these instruments.

A user-specified nonlinear relationship between the input signal and displayed
reading. Custom curve linearization is available with the Extended counter. One
way to supply the data is via a text file with up to 180 data points, which is
processed on a PC using furnished software and is then downloaded into
EEPROM via serial communications.

A programmable threshold in units of flow applicable to Total and Batch Control
with the process receiver and totalizer signal conditioner. Flow rates below the
cutoff, deemed to be zero offset errors, will not be totalized. Otherwise, small
zero offset errors could result in a large error if accumulated over a long time.

A band in counts which controls relay action
symmetrically around a setpoint. The relay
actuates when the reading falls within the
deviation band, and de-actuates when the
reading falls (e.g., 50 counts) is set up
around both sides of the setpoint to create a
deviation band (e.g., 100 counts). Setting up
a passband around a setpoint is often used
for component testing. Deviation limits are
programmed by entering menu item dEU1b
for Alarm 1 and dEU2b for Alarm 2. The deviation band will be equal to two
limits.

ON or OFF period of square waves as a percentage of total period over a gate
time which is selectable from 10 ms to 199.99 sec. With the dual input signal
conditioner, the same signal is applied to Channels A and B. Duty cycle can
then be read out with resolution to 0.01%.

Extended counter

Frequency

Gate Time

A counter with an enhanced microcomputer main board that provides added
capabilities, such as custom curve linearization of nonlinear inputs and display
of rate of change from successive readings.

Rate in cycles per second or Hertz (Hz). In rate meter mode, a scale factor of 1
and offset of 0 cause a display directly in Hertz with resolution of 1 Hz. To
increase or decrease resolution, increase or decrease the scale factor.

A user-specified time interval from 10 ms to 199.99 sec over which the meter
measures frequency. The meter times an integral number of signal periods
over the gate time, and then taking the inverse of period. The display update
rate of the meter is gate time + 1 period + 30 ms. Selecting a longer gate time

produces a more stable reading as more cycles are averaged, but slows
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Jumper

down the update rate. At very low frequencies, the update rate of the meter is
controlled by the period. In totalizing mode, the gate is always open, but the
gate time setting still determines the update rate of the meter. See also Time-
out or Time before zero output.

A push-on component which provides a short between two adjacent posts on a
circuit board. Jumpers are used to configure the circuit board, for example for
different signal ranges. Jumper positions are not sensed by the meter software.

Hysteresis band

ltem #

Menu mode

Meter Hold

Modbus

A band in counts which controls relay action

symmetrically around a setpoint. The relay

closes (or opens) when the reading goes

above the setpoint plus one hysteresis limit,

and opens (or closes) when the reading

falls below the setpoint less one hysteresis

limit. A narrow hysteresis band is often

used to minimize relay chatter around a

setpoint due to electrical noise or signal

feedback caused by load switching. A wide

hysteresis band can be used for control

applications. Hysteresis limits are programmed by entering menu item dEU1H
for Alarm 1 and dEUZ2H for Alarm 2. The hysteresis band will be equal to two
hysteresis limits.

Also called Display Item. A numerical value in the meter available for display
under control of a front panel key or serial communications. For example, in the
A+B totalizer mode, the sum of A+B is Item #1, Total A is Item #2, and Total B
is Item #3. When the meter is reset, Item #1 is always displayed. To view
another Item, press the RESET key. For Item 1, the yellow View “V” LED is
unlit. For Item 2, the “V” LED is lit. For Item 3 the “V” LED flashes.

Meter programming mode used for input and range selection, setup, and confi-
guration. Entered into from the Run mode by pressing the MENU key. The
Menu mode can be locked out completely by a jumper on the power supply
board.

A rear panel input which freezes the meter display and all meter outputs while
that input is tied to logic ground by a switch or is held at OV (logic level true).
The meter will resume operation when the input is disconnected or is held at
+5V (logic level false).

An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by these meters.

Moving average filter

A digital filter mode which displays a moving average of readings. Eight moving
average modes are selectable with the following equivalent RC time constants:
no filter, 0.1 sec, 0.2 sec, 0.4 sec, 0.8 sec, 1.6 sec, 3.2 sec, 6.4 sec.
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Multiplier

Offset

Peak display

Period

Phase angle

Process signal

Quadrature

Rate

A constant multiplier from 0.00001 to 100000 (in decade steps) that is com-
bined with a scale factor from 0.00000 to 9.99999 (fixed decimal point and
settable digits) to go from frequency in Hz to rate in engineering units such as
gallons per minute or from pulse counts to total in engineering units, such as
gallons. The combination of a 6-digit scale factor with a multiplier provides
more dynamic range with no loss of resolution than could be achieved with a 6-
digit scale factor only.

A constant adder to the displayed reading. This may be any value from
-999,999 to 999,99. The offset may be used as a preset in the totalize mode,
where the total can be counted down from the preset to zero.

The maximum (or most positive) reading since that value was last reset. Reset
can be via the meter front panel, an external input, or a software command.
The displayed value can reflect the filtered or unfiltered readings.

The time of one complete cycle of the input frequency. A scale factor of 1 and
multiplier of 1 produce a display in microseconds.

The lead or lag in degrees between two AC signals of the same frequency.
With the signals applied to Channels A and B of the dual input signal condi-
tioner, phase angle can be displayed from -180°to +18 0° with resolution to
0.01°

An analog signal whose display requires setup of scale and offset for display in
engineering units (such as psi). The process receiver & totalizer signal
conditioner accepts 0-1 mA, 4-20 mA or 0-10 V process signals.

A quadrature encoder generates 2 signals that are 90° out of phase based on
the position of a rotor or linear scale. The phase relationship of these signals
depends on the direction of rotation of the encoder. The meter counts up or
down depending on the phase. Quadrature is used for very accurate determi-
nation of length or position.

Same as frequency, except that a scale factor and multiplier have been applied
to convert the reading in Hz to a reading in engineering units, such as revolu-
tions per minute or gallons per hour.

Remote Display

Reset

Resolution

A display mode which allows the meter to serve as a 6-digit remote display
when connected to a computer or other meter via a serial communications link.
A serial communications option board is required in the meter.

Two types of Reset are applicable to counter/timer operation:
Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.
Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.

A menu item which controls the resolution of arithmetic functions (A+B, A-B,
AxB, A/B, A/B-1) of Grand Total in batch mode. It multiplies the displayed value
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by a factor of 0.00001 to 100,000 in decade steps. The decimal point then has
to be moved appropriately.

RS485 half duplex
Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.

RS485 full duplex
Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.

Scale factor A constant multiplier used to go from a raw reading in pulses per second or
total pulses to a reading in engineering units. The scale factor consists of a
scale value from 0.00000 to 9.99999 (fixed decimal point, settable digits) and a
scale multiplier from 0.00001 to 100000 (in decade steps)..

Scaling, coordinates of 2 points method
A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
then applies a straight line fit. The decimal point is set by the separate dEC.Pt1
menu item.

Scaling, scale and offset method
A scaling method where scale and offset are entered manually.

Setpoint A value compared to the reading to determine the state of a relay. Used
interchangeably with “alarm setpoint.” The relay action can by latching or non-
latching, utilize a hysteresis band, or a deviation band. Hysteresis bands and
deviation bands are specified by two symmetrical limits around the setpoint.

Stopwatch mode
A timing operating mode for single events. Stopwatch A-to-A measures time
between the same positive (or negative) edge of start and stop pulses applied
to Channel A. Stopwatch A-to-B measures time between a start pulse on
Channel A and a stop pulse on Channel B.

Time interval mode
An timing mode for the average duration of repetitive events over a
programmed gate time. Time may be measured from the leading or trailing
edge of pulses applied to Channel A to the leading or trailing edge of pulses
applied to Channel B.

Time-out (or time before zero output)
The time the meter waits for a signal to start or end a conversion. If pulses are
not received before the time-out ends, the meter reads zero. The longer the
time-out, the lower the minimum frequency the meter can display. This term is
also used for the programmable time that the batch relay stays de-energized at
the end of a batch cycle.
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| 26. WARRANTY I

Electro-Numerics, Inc. warrants these products to be free of defects in materials and work-
manship for two years from the date of shipment to the original customer. This warranty
may be considered as unconditional provided that, in the opinion of Electro-Numerics, the
equipment has not been mechanically, environmentally, or electrically abused and has been
installed, maintained and operated within the limits of rated or normal usage. Defective
products must be sent, transportation charges prepaid, with notice of the defect, to our plant
in Temecula CA.

This warranty is limited, at the option of Electro-Numerics, Inc. to repair, replacement, or an
appropriate credit adjustment not to exceed the original equipment sales price. All warranty
freight charges are F.O.B. our plant, Temecula, CA.

Electro-Numerics assumes no responsibility in connection with the sale of its products
beyond that stated above and is not responsible for any incidental or consequential loss or
damage which might result from a failure of any Electro-Numerics, Inc. product.

27. REPAIR POLICY I

Direct all warranty and out-of-warranty requests/inquiries to Electro-Numerics, Inc.,
Customer Service Repair Dept., Tel: 800-854-8530 (USA) or 951-699-2437, by Fax to: 951-
695-7246 or by email to sales@electronumerics.com. Repair work will be handled at the
factory or an authorized service center. All items sent in for service are subject to a
minimum evaluation charge of $65 in the event that the product is found to be out-of-
warranty or, if under warranty, not in need of additional service. Out-of-warranty service and
repair charges will be quoted on a case-by-case basis. All repaired products will be shipped
FOB, Temecula, CA.

| 28. ELECTRO-NUMERICS, INC. PRODUCTS I

Electro-Numerics family of Digital Panel Meters and Large Digit Indicators are high quality,
accurate, solid state instruments designed for years of trouble-free operation. Over 30 years
of digital instrumentation experience has resulted in a series of displays recognized in the
field as reliable, well designed instruments. From our compact sized DPM's with 0.6" LEDs,
to our Large Digit indicators with 1", 2-1/4", 4" and 5" LEDs or 4", 6" and 9" tall
electromagnetic digits, we cover most applications in process measurement and display.

In addition to our digital display products, Electro-Numerics also manufactures magnetic
components including magnetic (VR) sensors, coils, transformers, ballasts and plug-in
power supplies. Please see www.electronumerics.com.
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ELECTRO-NUMERICS, INC.
42213 Sarah Way, Temecula CA 92590 U.S.A.
Tel: 800-854-8530 (U.S.A) or 951-699-2437
Fax: 951-695-7246, Email: sales@electronumerics.com
URL: www.electronumerics.com
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